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Introduction 

Windows010 is one of the most versatile OS Microsoft has 

ever made, and0it’s an operating system like no other.  

Instead of rolling0out a completely overhauled OS every few 

years, MIcrosoft0gives Windows 10 free yet very tangible 

updates semi-annually, the latest of which is the May 2020 

Update. This0approach allows the OS to consistently bring in 

new features and support with its semi-annual updates, 

allowing it0to reach far beyond how traditional PCs work. 

And, it’s0worked out so well that Windows 10 has 

quickly taken0Windows 7’s mantle as Microsoft’s most 

popular OS. 

Of course, much0like its predecessors, Windows 10 also 

comes with several different versions meant for different 

types of hardware0and specific users, adding to its 

versatility. These versions include Windows 10 Pro that 

offers enterprise-grade0security and tools and the more 

locked down and lightweight Windows 10 in S Mode. Also 

coming are Windows 100Lite, which will compete with the 

ChromeOS and the best Chromebooks, and Windows 10X, 

which is designed for0dual-screen and foldable devices. 

From its key features to its semi-annual updates, we gathered 

everything you need0to know about the powerful and 
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extremely versatile Windows 10 OS. Read on and find out 

what makes it tick and0how you can maximize it. 
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How to Set up Window 10 

Step 1: Run All Windows Updates 

1. Type "updates" in0the search box. 

 

2. Click "Check for0updates." 

 

Windows will start0searching for and downloading updates, 

but you don't have to wait for this process to complete before 

moving on to your0next task. 
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3. If Windows0doesn't automatically search for 

updates, select the "Check for updates" box.  

Step 2: Uninstall0Bloatware 

Most PC0vendors put lots of third-party, preloaded software 

on your computer. From 30-day trials of antivirus software to 

casual0games (ex: Candy Crush) you may not want to play, 

all of this bloatware is sucking up system resources. To 

uninstall bloatware: 0 

1. Navigate0to Settings. You can get there from the Start 

Menu. 

 

2. Select0System. 
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3. Select0Apps and Features from the left menu. If you 

don't see this option, press inside the search box and type 

Apps, then0select Apps and Features. Alternatively, you can 

skip steps 1 and 2 and type "Uninstall" from the Search Box 

on the Taskbar0and choose "Add or remove programs."  

 

4. Select0an app you wish to uninstall. 

 

5. Click0Uninstall. 
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6. Click the second0uninstall button that appears. 

 

Step 3: Copy or Sync0Your Files 

What good is your new computer if it doesn't have your most 

important data on it? There0are several possible ways to 

move your documents, photos, videos and other key files over 

from an old computer.  These0include 

 OneDrive Sync: If0your important files are stored 

in One Drive, they will automatically download to the new 

computer once you log0into the new PC with your 

Microsoft account. 

 Dropbox or Google Drive: These0services work just 

like OneDrive but don't come preloaded with Windows 

(unless your laptop manufacturer put0them there). If you 

were using them to store files on your old computer, 

install them on the new0one. 

 Copy files manually. Select all the files under your 

Documents, Music, Videos0and Photos libraries, copy 

them to an external drive (ex: Flash drives, hard drives) 
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and then copy them over0to the new machine. This is a bit 

tedious so we recommend0using Cloud storage if 

possible. 

 

Step 4: Install Antivirus  

Antivirus software is0important no matter how careful you 

think you are on the internet. If you hit even one wrong link, 

accidentally or0otherwise, your entire computer could 

become victim to a malware infection — an awful scenario 

that can generally be0avoided with some good antivirus 

software. The point of antivirus software is to prevent these 

sorts of situations0before they happen and, if that fails, fix 

them immediately afterward. It's crucial that you have some 

sort of antivirus0software to shield your PC fromthreats. 

Step 5: Set Up Windows Hello Fingerprint or Face 

Logins0 

Many0current-generation laptops come with either a 

fingerprint reader or an infrared camera for facial 
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recognition. If you0have either one, you should set 

up Windows Hello, a feature that lets you log in with a finger 

or a glance, so you can avoid0the hassle of using a normal 

password. This is another great security feature to have to 

keep your files protected.  

1. Navigate0to Settings. 

2. Click Accounts. 

 

 

3. Select0Sign-in options. 

 

4. Click the Set up button0under either Fingerprint or 

Face Recognition. 
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5. Click Get Started. 

 

6. Swipe your finger (for0fingerprint readers) or stare at 

the camera (for facial recognition) as directed. If you don't 

have a fingerprint reader or0an IR camera, Windows 10 

won't let you proceed. 
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7. Click Set up PIN. Windows010 requires that you have a 

PIN as a back up, in case your finger or face doesn't register. 

You won't be asked to do this if0you already have a PIN. 

 

8. Enter0a PIN and click OK. 
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Step 6: Install0Your Browser of Choice (or stick with 

Edge) 

Microsoft's Edge0Browser is fast, lightweight and definitely 

worth considering. However, if you're used to using Chrome 

and Firefox and0you have accounts and/or extensions set up 

in them, you'll want your favorite browser right away. To set 

your new browser0as the default, follow these steps. 

1. Download and run the browser installer of your 

choice.Chromeisat0https://www.google.com/chrome/brows

er/desktop/ 

2. Navigate to0settings. You can get there from the Start 

Menu. 

 

3. Click0System. 
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4. Select0Default apps in the left pane. 

 

5. Click the0icon under Web browser. It may 

say "Choose a default" or it may have the icon for the current 

default0browser.  

 

6. Select0your browser in the pop-up menu that appears. 
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How customize your Windows 10 theme. 

Right0click on the desktop and select Personalize.  

 

The0personalization menu appears.  

 

Desktop0Wallpaper 

How to Change your Desktop Wallpaper: 

1. Select0Picture, Solid Color or Slideshow from the 

Background0menu. 
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2a. if you0picked "picture," select a photo from the list or 

browse for one on your hard drive. 

 

2b. if you0picked, "solid color," select one of the 

available shades. 
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2c. if you0chose "Slideshow," decide which folder you 

want the show to draw from. It defaults to your pictures 

library. 0 

 

Windows 10 Settings You Should Change 

Right Away? 

Enable0System Protection / Create a 

Restore Point 

Windows 100comes with system protection disabled. If you 

want to protect yourself -- and you should -- set up restore 

points following0the instructions below. 

1. Search for0"restore point" in the Windows search 

box. 
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2. Launch0"Create a restore point" from the 

results. You should see a list of available drives. 

 

3. Select0the system drive and click Configure. The 

system drive is usually the C: drive and has the word 

"(System)" written0after its volume name. 

 

4. Toggle Restore0Settings to "Turn on system 

protection," set the maximum disk space usage by 

moving the slider and0click Ok. We recommend leaving 2 
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or 3 percent for restore pints but you may be able to get away 

with the lowest (10percent). 

 

5. Click Create so0that you create an initial restore point 

right away. 

 

6. Name the initial0restore point when prompted. 
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7. Click Close when0it is done. 

 

If you need to restore from0one of these points, you can click 

the System Restore button on the System Protection tab. If 

you can't boot, you can hit0F8 or Shift + F8 during boot to 

get to the emergency menu on some computers. On other 

PCs, if you can at least get to0the log in screen, you can hold 

down Shift while you select Restart. 
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Windows 10 Keyboard Shortcuts Will Save 

You Clicks 

 

Any time you can0hit a key combination instead of rolling 

your mouse pointer across the screen, you save a lot of time. 

Windows 10 has a0long list of keyboard shortcuts that help 

you launch new features such as Cortana, navigate around 

the OS or organize your0desktop layout with ease. While you 

might know some of the traditional Windows keyboard 

shortcuts, you will be0surprised to find some new tricks 

below.  

Cortana Shortcuts 

Windows + Q: Opens0Cortana's Home View, enables 

search by speech or keyboard input. 

Windows + C: Opens0Cortana's speech prompt 

New in Windows 10 

Windows Key + A: Opens0Windows 10 notifications 
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Windows Key + I: Opens Windows 10 settings 

Windows Key + Ctrl + D: Creates0new virtual desktop 

Windows Key + Ctrl + F4: Closes current virtual desktop 

Windows Key + Ctrl + Left or0Right: Switches between 

virtual desktops 

Windows Key + F1: Opens Edge0and Searches "How do I 

get help in Windows 10" with Bing (formerly opens Help) 

Windows Key + Print Screen Key: Creates0a 

screenshot of the whole screen in the Photos app. 

Windows Standards 

Windows Key: Shows0the Windows 10 Start Menu  

Windows Key + L: Locks your Windows 10 device 

Windows Key + Tab: Launches0Windows 10 Task View 

Windows Key + Enter: Opens Narrator, a program that 

reads text for you and shows you0tips. 

Desktop Commands 

Windows Key + X: Opens Start0button context menu 

Windows Key + Left, Right, Up or Down: Moves the 

active window around on your0screen. Left and Right 

snap the window to either side so it takes up half of the 
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screen, Up and Down shrink the window to a0quarter-size 

and move it to that corner. Once you have used Windows Key 

+ Up to place it in the top corner, pressing0that 

command again makes the window take up your whole 

screen. If you have hit Windows Key + Down 

to place a0window in the bottom corner, hitting that 

command again minimizes the window. 

Windows Key + D: Show0Windows desktop (also available 

with Windows Key + M) 

Windows Key +, Temporarily0show desktop 

Connecting and Sharing 

Windows Key + H: Share0content (if supported by current 

app) 

Windows Key + K: Connect0to wireless displays and audio 

devices  

Windows Key + E: Open Windows0Explorer 

Traditional Keyboard Shortcuts 

Windows Key + Space: Switch0keyboard input language 

(if you have added at least a second one) 
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Windows Key + Shift + Left0or Right: Move current 

Window from one monitor to another (when using a multiple 

monitor0setup) 

Windows Key + 1, 2, 3 and so on: Open programs that 

are pinned0to task bar 

Windows Key + R: Run a command 

Windows0Key + P: Project a screen 

Alt + Tab: Switch to previous window 

Windows0Key + T = Cycle through screenshots of 

open apps 

Alt + F4: Close0current window, but if you perform this 

combination when viewing the desktop, you open Power 

dialogue to shut0down or restart Windows, put your device 

in sleep mode, sign out or switch the current user. 

How To Take a Screenshot of Your Whole 

Screen 

1. Tap the Print0Screen button on your keyboard. The 

screen shot is now stored in your clipboard and you need to 

paste it into a graphics0editor such as Windows Paint. 

2. Type "paint" into the search bar next to the Start 

menu. 
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3. Select "Paint" 

4. Click0"Paste" 

 

Your0screenshot is ready! 

 How to Take a Screenshot of Just 

the Active Window 

1. Hit0Alt + Print Screen.  
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2. Type0"paint" into the search bar next to the Start 

menu (if Paint is already open, click Control+N and then 

select OK0when Paint asks you to approve the height and 

width). 

 

3. Select "Paint" 

4. Click0"Paste" 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

25 
 

 

Your0screenshot is just of the window you had open and 

active! 

 

3. How0to Make a Screenshot File without 

Any Additional Programs  

1. Hit Windows0key + Print Screen. 

When you navigate to the Screenshots folder inside of 

your Pictures, your0screenshot will be there! 
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4. How to0Take a Screenshot of a Specific 

Part of Your Screen 

1. Type "snipping0tool" into the search bar next to the 

Start menu. 

 

2. Select "Snipping Tool" 

4. Click and drag the0cursor to select the area of the 

screen you want to use; release the cursor once you've 

selected the space you0want to capture. 

Your screenshot is open in0Snipping Tool! 
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5. How to Take Screenshots with Even 

More Tricks 

1. Open PicPick's download0page, and click on "Free 

Download" 

 

2. Follow the instructions to install PicPick, and you 

will find a menu of specific0methods for capturing part or all 

of your screen. Clicking "Scrolling Window" will let you 

capture as much of a0page or document as you can scroll 

through, rather than0just the static version of the window.  
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3. Installing PicPick0will change your computer's key 

commands for screenshots, so you should make yourself 

aware of those commands. Click0on the "Show hidden 

icons" arrow in the bottom right corner of the 

screen. 

4. Click on PicPick's0icon. 

5. Select "Program Options" 

 

6. Select "Hot keys" from0the left-hand menu. 
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How to Change Your Password in 

Windows 10 

To Change / Set a Password: 

1. Click the Start button at0the bottom left of your screen. 

2. Click Settings from the list to the left. 

 

3. Select Accounts. 

4. Select Sign-in options from0the menu. 

5. Click on Change under Change your account password. 
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6.  In order to change your0password, you have to sign in 

with your current Microsoft account password. Enter your 

password in the box. Click0Sign in. 

7.  Microsoft will send you a new code to change your 

password through the phone0number that is associated with 

your account. Enter the last four digits of your phone 

number to verify it is the0correct number. Press Enter. 

8. You will receive a code on your phone. Enter the code. 

9. A new page will0direct you to enter your old 

password and then type in a new password. Reenter 

the new password. Press0Enter. 

Change Your Password to a PIN 

1.  Follow steps 1-4 under0To Change Your Current 

Password above. 

2. Within Sign-in options, click0on Add under PIN. 

3. In order to change your password, you have to sign in with 

your current Microsoft account0password. Enter your 

password in the box. Click Sign in. 

4. Enter a new pin in the first0box and reenter it in the 

second one. Click OK. You can now use this pin to sign into 

your Microsoft0account. 
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Change Your Password to a Picture 

Password 

1. Follow the0steps 1-4 under Change Your Current 

Password above. 

2. Within Sign-in0options, click on Add under Picture 

Password. 

3. Enter your0Microsoft account password to verify 

it's your account. Click OK. 

4. Click on0Choose Picture. Choose a photo from your 

files. 

5.  Click on0Use this picture if you like it or click on 

Choose new picture if you don't. You can drag your photo 

to position it0however you want. 

6. You will have to set up three gestures that will become part 

of your picture0password. With your cursor, draw lines or 

circles that coordinate with your photo. 

How to Uninstall Programs in Windows 10 

1. Open the0Start menu. 

2. Click Settings. 
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3. Click System0on the Settings menu. 

 

4. Select Apps &0features from the left pane.  

 

A list of all installed0apps appears in the right pane. 

5. Select an app you wish to uninstall.  
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6. Click the0Uninstall button that appears. If it is grayed 

out, this is a0system app you cannot remove. 

 

7. Click the0Uninstall pop-up button to confirm. 
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How to Enable or Disable Tablet Mode in 

Windows 10 

Configuring0Tablet Mode involves three basic actions: 

1. Go to the Tablet Mode tab under Settings -> System. 

2. Toggle0the "make Windows more touch friendly" 

option on or off. 

3. Select0whether the device switches modes 

automatically, prompts you or never switches. 

Step-by-Step0Instructions with Screenshots 

1. Click Settings on the Start Menu. 

2. Select0System. 

3. 3. Select Tablet mode in the left pane. A Tablet 

mode submenu0appears. 

4. Toggle "Make Windows more touch-friendly . . 

." to on to0enable Tablet mode. Toggle it off to go to 

desktop mode.  

5. Select "Don't0ask me and always switch" from 

the "When this device automatically switches" 

menu if you want0Windows 10 to switch modes on 

your 2-in-1 without prompting you. 
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How to Add a Child or Adult User in 

Windows 10 

1. Navigate to0Settings. You can get there from the 

Start menu. 

2. Click0Accounts. 

3.  Click Family & Other Users in the left window 

pane. 0 

 

4. Click "Add0a family member" or "Add 

someone else to this PC." Choose "family member" 

if you are either adding0a child or adding an adult who 

needs access to parental control settings for child 

users. If no children are0using this computer, using 

"Add someone else . . " should be fine. 
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Follow the instructions0below, based on what type of user 

you wish to add. 

To Add another Adult User: 

1. Click "Add someone0else to this PC." 

2. Enter the person's email address and click Next. 

This address should be tied0to the person's Microsoft 

account.  

3. Click Finish. 0 

If you want this0user to be able to install desktop software or 

change settings, follow the instructions below to make them 

an0administrator. 

1. Open control panel. You can get there by hitting 

Windows0+ X and selecting control panel. 

2. Open the User Accounts menu. 

3. Click0Manage another account. 

4. Select the account you wish to give admin rights to. 

5. Click0"Change the account type." 

6. Select Administrator and click the Change 

Account0Type button. 

To Add a Child: 

1. Click "Add a0Family Member." 

2. Select "Add a Child."  
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3. Enter the0child's Microsoft account email 

address. If they don't have a Microsoft account, you must 

sign them up for0one. If your child is too young to have an 

email address and you click "The person I want to add 

doesn't have an email0address," you will be prompted to 

create a Microsoft account and corresponding @outlook.com 

email address for0them. It's unfortunate that Microsoft 

requires child accounts to have email, but parents can use 

their own email address0or create a dummy one. 

4. Click Confirm. 

5. Click Close. The0child's email account will get an invite. 

6. Have the child click Accept on the email. 

The child may be0prompted to log in to their account. If the 

Microsoft account lists your child as being under  13, a parent 

will need to sign in0and confirm them as a family member. 

If you grant the child permission, you will be asked for a 

credit card number to0verify that you're actually an adult. So 

you might be better off just creating a dummy Microsoft 

account for your child and0registering with Microsoft for 

them.  

7. Click "Manage family settings online" in the 

Windows 10 account settings0menu. 
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Your browser will0open to the Microsoft website where you 

can manage all of your family members' access. 

8. Select the child0whose permissions you wish to manage. 

 

9. Use the controls0to set restrictions on what sites 

your child can see, what apps they can use and how long they 

can use the computer. By0default, you will also get weekly 

activity reports mailed to you. 
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To Add a Parent: 

A parent is like any0other adult user, but they also have the 

right to manage the child settings. 

1. Click "Add a0Family Member." 

2. Select Adult, enter the email address and click 

Next. The email0account should be tied to the new user's 

Microsoft account. 

3. Click Confirm. 0 

The person will0receive an email invitation and have to 

confirm it. 

How to Change Screen Resolution in 

Windows 10 

1. Click the0Start button. 

2. Select the Settings icon. 
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3. Select0System. 

4. Click advanced display settings. 

 

5. Click0on the menu under Resolution. 
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6. Select0the option you want. We strongly recommend 

going with the one that has (Recommended) next to it. 

 

7. Click Apply. 

 

You've0changed your display resolution! 
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How to Sync Your Settings in Windows 10 

With its0synced settings option, Windows 10 allows owners 

of multiple devices to keep their system preferences in 

harmony. This0way, you don't need to spend time with the 

repetitive work of manually entering theme customizations, 

browser options0and various other settings into all of your 

machines. 

 

1. Click0the Start button. 

2. Click the Settings icon. 

3. Click0Accounts. 

4. Click Sign in with a Microsoft account and enter 

your0account information. Move to step 5 if you don't 

see that option. 

5. Click0Sync your settings. 

6. Turn on the switch next to Sync Settings. Apply 

steps 1-6 on your0other Windows 10 machines. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

43 
 

 

How to Sync your iPhone with Windows 10 

Copying to0an iPhone 

Syncing music, photos, movies and TV shows means getting 

comfortable0with iTunes. If you’re already using it, you’re 

good to go. If you’re not, you can download that here and 

import your0music by going to File > Add Folder to Library 

to move your current music into iTunes. Once you’re ready to 

sync, follow0these steps. 

1. Connect your iPhone to your laptop with a Lightning 

cable. 0 

2. Click0Continue when asked if the computer can have 

access to the phone. 

3. Click the0phone icon in the top bar. 

4. Click Sync. 
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This should0sync the two devices. If it doesn’t, go to the 

sidebar and enable the Sync checkboxes under Music, Apps, 

Movies, TV0Shows and Photos and click Sync again. 

 

Depending0on how much data you’re syncing, this may take 

awhile. Get a drink or a snack and come back later. 

5. Check your0photos, music, apps and videos to confirm 

that they arrived on the phone from Windows 10. 

Copying From0an iPhone 

This is where0things get tricky. In an attempt to avoid piracy, 

syncing from an iPhone isn’t as easy and sending data to it. 

Luckily, there0are some workarounds. 

 Music and0Movies: This keeps you stuck in Apple’s 

wheelhouse. Though you can move non-iTunes media files 

to your phone0from your PC, you can't send them from 

the handset to the computer. However if you buy media 

from iTunes on your0iPhone, you can get it on your 

desktop via the cloud. As long as you maintain one Apple 
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ID, you’ll be able to download0all your songs and movies 

again from iTunes on your PC at no extra cost. 

How to Control Windows 10 with Your 

Voice 

1. Type Windows0Speech into the Cortana search bar, 

and tap Windows Speech Recognition to open it. 

 

2. Click Next in the0pop-up window to get started. 

3. Select your microphone and press Next. If you want 

the best results, a0headset or other standalone microphone 

is a solid bet. For laptop users, or those with built-in mics, 

these will work just0fine. 

4. Follow the on-screen instructions for microphone 

placement, and0press Next once you’re ready. 

5. Read the on-screen prompt to calibrate the 

microphone and press0Next. 
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6. Choose whether to allow your computer to review 

documents0and e-mail to better understand you when 

you speak. 

7. Select0an activation mode. Windows Speech 

Recognition can turn off when you say “Stop Listening” with 

voice activation0mode, or you can choose to use a key 

combination (CTRL + Windows) to activate and de-activate 

the0service. 

8. Print the speech recognition card for easy access to 

the commands0Windows understands,  

9. Choose to run Speech Recognition at startup, or 

you’ll have to0manually enable it through the control panel. 

10. Finish the setup by watching the tutorial to learn more 

about Speech0Recognition’s capabilities. 

How to Eliminate Blue Light with 

Windows 10 Night Light 

1. Open the0Start Menu. 
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2. Click the0gear icon to bring up the Settings Menu. 

 

3. Choose0System. 

 

4. Select0Display. 
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5. Toggle the Night light switch to On. 

 

6. Click0Night light settings to adjust the level of 

blue displayed, or determine the time for Night Light to 

activate0automatically.  
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How0to Create a New Folder in Windows 

10 

Method01: Create a New Folder with a Keyboard 

Shortcut 

The fastest0way to create a new folder in Windows is with 

the CTRL+Shift+N shortcut. 

1. Navigate0to the location where you want to create 

the folder. You can create a new folder at any location on 

your hard drive0or within another folder (creating a 

subfolder) in File Explorer. You can also create a new folder 

on your desktop with0this method. 

2. Hold down the Ctrl, Shift, and N keys at the same 

time. Windows0will immediately create the new folder with 

the not-very-imaginative suggested folder name of "New 

folder." 0 

 

3. Enter0your desired folder name. It takes just seconds 

to create a new folder this way, but be sure to immediately 
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begin typing0your folder name when the folder first appears, 

because if you click on the folder or click away from File 

Explorer, the0folder name will be "New folder" and you'll 

have to rename it. 

Method 2: Create0a New Folder by Right-

Clicking 

If you don't remember the keyboard shortcut or you prefer 

using the0mouse: 

1. Navigate to the location where you want to create 

the0folder. 

2. Right-click on a blank space in the folder location. 

Take care0with this: If you right-click on an existing item in 

the folder, you'll get the wrong menu. 

3. Select0New then Folder from the contextual menu. 

Windows will create the new folder at your current location. 

 

4. Enter0your desired folder name to replace "New 

folder" and hit Enter. 
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You can0create folders on the Desktop using this method 

too. Right-click on a blank space on the Desktop, then go to 

New > Folder. 0 

Method 3: Create a New Folder from the Ribbon 

Menu 

Another0simple way to create a new folder is to use the New 

folder button in the File Explorer menu. 

Just0navigate to the place you want the folder and click or 

tap "New folder" in the Home tab 

 

In addition0to the methods above, you can create a new 

folder in Windows 10 by using the Command Prompt 

(navigate to the location0you want your folder in and type 

mkdir foldername, replacing "foldername" with your folder 

name). These three0methods, however, are the simplest and 

quickest ways to create a new folder, so you can get right to 

organizing your0files. 
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How to Get to the Desktop in Windows 10 

If you0do a lot of multitasking, your screen gets covered in 

different windows. But what do you do when you need to find 

that icon0or folder on the desktop or you just want to 

hide the clutter? 

You could0go hit the minimize button on all your open 

windows, or you could minimize them all at once with a 

single click or0keyboard combo. Here's how to get to the 

desktop in Windows 10 with just one short action. 

 Using0your mouse: Click the small rectangle on the far 

right side of the taskbar.  

 Using0your keyboard: Hit Windows + D. 

In either case, performing the action a second time (clicking 

or typing) brings0all the windows back. 

How to Add a Printer  

Add a Local Printer 

1. Connect the0printer to your computer using the 

USB cable and turn it on. 

2. Open the0Settings app from the Start menu. 
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3. Click0Devices. 

 

4. Click0Add a printer or scanner. 
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5. If Windows0detects your printer, click on the name of 

the printer and follow the on-screen instructions to 

finish the0installation. And you're done. 

If Windows doesn't find your connected printer, click on 

"The printer that0I want isn't listed" link. 

 

Then let the0Windows troubleshooting guide help you find 

your printer. It will search for available printers and help you 

download the0drivers for them. 
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If that doesn't0work, head to your printer manufacturer's 

website and download the drivers and installation tools for 

your0printer. 

Add a Wireless Printer 

The0steps to install a wireless printer may vary by 

manufacturer. In general, however, modern printers today 

will detect0your network and automate the installation. 

1. Use the printer's LCD panel to enter the wireless 

setup. On0my Epson printer this is under Setup > Wireless 

LAN Settings. 

2. Select0your Wi-Fi network. You'll need to know your 

home network's SSID, which you can find by hovering your 

mouse over0the Wi-Fi icon in the taskbar. 

3. Enter your network password. 

In some0cases, you might need to temporarily connect your 

printer to your computer via USB to install software. But 

otherwise, that's0it. You should find your printer 

automatically added in the Printers & scanners section under 

Settings > Devices. 0 

If you run into0trouble, make sure your printer is relatively 

close to your computer and not too far from your wireless 

router. If your0printer has an Ethernet jack, you could also 
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connect it directly to your router and manage it with a 

browser interface. 0 

Add a Shared Printer 

Windows'0home networking feature called HomeGroup 

automatically shares printers and certain files with other 

computers0on your home network. Here we'll set up a 

HomeGroup, if you don't already have one set up, and 

connect to the shared0printer. 

Set Up a HomeGroup 

Skip this step if0your home network already has a 

HomeGroup set up. If you're not sure, follow steps 1 and 2 

below to0check. 

1. Right-click on the wireless icon in the taskbar and 

select "Open0Network and Sharing Center". 

 

2. Click "Ready0to create" next to HomeGroup. If a 

HomeGroup already exists on your network, it will say 

"Joined." 0 
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3. Click the0Create a homegroup button. 

 

4. Click Next. 

5. Select what0you want to be shared. Printers & 

Devices are shared by default.\ 
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6. Write down the HomeGroup password Windows 

creates for you. You'll0need it for each computer you want to 

join the HomeGroup. 

7. Click Finish. 0 

Connect to a Shared Printer on the 

0HomeGroup 

Now head to the0other computer(s) on your network to join 

the HomeGroup. 

1. Click Homegroup0and then the Join now button in 

Windows Explorer. 

 

2. Click0Next. 
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3. Verify0what you want to share and click Next. 

 

4. Enter the0password and click Next. 

 

5. Click Finish. 
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6. Click0Network in Windows Explorer and you should see 

the shared0printer installed. 

 

How to Set Alarms  

1. Type0"alarm" into the Windows search box. 

 

2. Click0the "Alarms & Clock" icon. 
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3. Click0the plug button to add a new alarm time. You can 

also select an existing alarm to edit it. 

4. Set an0alarm time. You can also set the alarm sound, 

snooze time, number of times the alarm repeats and the 

name of the0alarm, but these are all optional settings. 

 

5. Click0the save button in the lower right corner of the 

window. 

Note that, on0most computers, the alarm screen will say that 

"Notifications will only show if the PC is awake." So, for your 
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alarm to go off, you0will need to configure your computer 

NOT to go to sleep.  

To0stop your computer from sleeping: 

1. Type "sleep" into the Windows search box 

 

2. Click0"Power and Sleep Settings" 

 

3. Set Sleep0time to "Never" under "when plugged in" 

and / or "on battery." If you don't let it sleep when you're on 

battery, your0computer could run out of juice. 
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How to0Upgrade to Windows 10 From 

Windows 7 or 8 

Windows 100should install without a hitch, but driver 

problems are a possibility and, during any system update, 

there's always0a chance something will go wrong. Before you 

begin the process, make sure you have all of your data files 

backed up, preferably0to a cloud service such as Microsoft's 

own One Drive, where you can download them again if your 

computer crashes. If0you don't have a system restore disk 

already, it's a good idea to make a full system backup, using 

disk imaging software0such as Macrium Reflect, which 

makes a bit-by-bit copy of your hard drive. 

Finally, make sure0you have 1 to 2 hours free to run 

the install. Though you can walk away for large portions of 

the process, you can0expect all the downloading and file 

copying to take at least 60 minutes and, in our case, closer to 

two hours on a fast0Internet connection. If you have slow or 
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inconsistent Internet, you should go to some place that has a 

strong connection0and follow the instructions for creating a 

USB install disk you can use at home. 

How to Upgrade Via Direct Download 

1. Navigate0to https://www.microsoft.com/en-

us/software-download/windows10 

2. Click0the "Download Tool now" button 

3. Launch the Download Tool. 

4. Click0Select Upgrade this PC Now if you are just 

installing on this computer and want to do so right away. 

However, if0you want to create your own USB or DVD 

media, see the section below on "How to Create Windows 8 

Install Media." Though0it requires a few extra steps and a 

blank Flash drive or disc, creating your own install media 

allows you to not only install0on multiple computers, but 

also reinstall on your current computer if something goes 

wrong. 

The tool will take0a while to download the software so be 

patient, particularly if you have a slow Internet connection. 

After it0downloads, the software also goes through a 

preparation process and downloads some more files, all of 
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which takes0time, perhaps as long as an hour even on a high-

speed connection. 

5. Click Accept0on the license terms screen. Wait again as 

the software checks for updates. You may want to walk away, 

as this also takes0several minutes. 

6. If you're upgrading from Windows 7 make sure to select 

"keep personal0files and app" or the upgrade won't work. 

Then Click the Install button. Wait 20 to 30 minutes for 

the computer to0copy files. It will reboot several times. 

7. Click Next at the login screen. 

8. Click Use0Express settings. You can always change 

some settings later. 

9. Click Next0on the "New apps for the new Windows" 

screen. The computer will say "finalizing your settings," and 

then take you to0the Windows 10 lock screen. 

10. Log in to your computer. Windows 10 will take 

another couple of minutes0to do an initial setup and then it 

will take you to the Windows desktop. 

How to Create a Windows 10 USB Install 

Disk 

If you have a 4GB0or larger USB flash drive or a blank DVD 

handy (and you still use an optical drive), you can create your 
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own Windows 100install disk. Having your own disk allows 

you to run the upgrade on multiple computers without 

waiting an hour for a fresh0download. You also have the 

option of doing a clean install or running the upgrade a 

second time if you run into problems0later. Here's how to 

create a Windows 10 install disk.  

Before you begin, make0sure to insert your flash drive into 

one of your USB ports. Be aware that all data on the drive will 

be0erased. 

1. Follow steps 1 -3 above, installing the Download tool 

and launching0it. 

2. Select "Create installation media . . . " 

 3. Select the0language, edition and architecture (32 

or 64 bits) of Windows. Make sure your selections match 

those of the0computer(s) you wish to upgrade. So, if you 

currently have Windows 8 Home (64-bit), choose Windows 

10 Home064-bit. 

4. Select0USB flash drive. If you plan to burn this to DVD 

instead, select ISO file and, after the process is over, you'll 

have to use0a DVD burning program to write the ISO to disc. 

5. Click Finish when the process is complete. If you don't 

plan to install0Windows 10 right away, you can remove the 

drive and stop here. 
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6. Launch0setup.exe on the flash drive to start the 

upgrade process. 

7. Select0"Download and install updates" and click 

Next. If you are in a big hurry, choose "Not right now." Wait 

several minutes0for the updates to download. 

If the software asks you for a product key, you are using the 

wrong version of0Windows 10 to upgrade. For example, you 

might be attempting to install Windows 10 Home over your 

existing Windows 8.1 Pro0or vice versa. The following steps 

are the same as if you install via direct download. 

8. Click Accept. The0software takes a couple of minutes to 

check your system.  

9. Click Install. You0can now walk away for at least 30 

minutes. After the OS is finished installing, you will be 

presented with a screen0showing your username. 

10. Click the Next button. 

11. Select Use Express0settings. 

12. Click Next again. 

13. Log in to your0computer.  
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How to Create Keyboard Shortcuts in 

Windows 10 

Method 1: Create0a Desktop Shortcut 

1. Open a command prompt window. You can get there 

by typing "cmd" into0the Cortana / Search box and then 

right clicking on Command Prompt and selecting "Run as 

administrator." 0 

 

2. Type "explorer0shell:AppsFolder" (without quotes) 

at the command prompt and hit Enter. A window with a list 

of all your apps0appears. 
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3. Right0click on an app and select Create shortcut. It 

may be easier to find your app if you change the view setting 

to "detailed0list" so you can see all the icons in a single 

column. 

 

4. Click Yes0when asked if you want the shortcut on the 

desktop. A new shortcut icon appears on your desktop. 

5. Right click0on the new shortcut icon and select 

Properties. 
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6. Enter a key0combination in the Shortcut key 

field. The combination must be CTRL + ALT + a letter / 

number. 0 
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7. Click0OK. 

Note: Remember not to use the same key combination twice. 

Also note0that some programs use CTRL + ALT + keyboard 

shortcuts that would also launch if you were in their 

windows. For0example, in Photoshop Elements, CTRL + 

ALT + I brings up the resize menu. 

Method 2: Use the Start Menu 

If you're0creating a keyboard shortcut for a "desktop app," 

any application that installs via direct download rather than 

Windows0Store alone, you can create the shortcut directly 

from the Start Menu. By using this method, you can avoid 

creating a0separate shortcut icon on the desktop. 
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1. Open the Start Menu. 

2. Navigate0to the icon or tile for the app you want. If 

the app is not pinned as a tile, you can find it by clicking on 

the All apps and0scrolling through the alphabetical list. 

 

3. Right0click and select Open file location. A window 

opens with a shortcut icon. If Open file location doesn't 

appear on the0menu, this is a modern or universal app and 

you'll have to follow method 1 above. 

 

4. Right0click on the shortcut icon and select 

Properties. 
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5. Enter a0key combination in the "Shortcut key" 

box.  

 

How to Change the Default Font in 

Windows 10 

1. Press0Win+R. 
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2. Type in regedit and press Enter. 

 

3. Go to0File > Export… to save the registry file 

somewhere0on your hard drive. 

 

4. Open0Notepad and copy and paste the following 

into it: 

Replace0Verdana in the last line with the name of 

the font you want to use as your system default. You might 

have to open your0Fonts folder (search for "fonts" in the 

Windows taskbar) to get the full, correct name of the font. 
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5. Click File > Save. 

6. Change the "Save0as" type to "All Files." 

 

7. In the File name0field, give the file a .reg 

extension. You can name it anything, as long as it ends in 

.reg. 0 

8. Click Save. 

9. Double-click0the registry file you just created to 

run it. You'll be prompted to allow the file to make changes to 

the computer and0confirm you want to continue, then get 

confirmation the changes were successfully made. 

10. Restart your0computer to see the font change applied 

across Windows 10. 

Just don't change0the default font to something like 

Wingdings, lest you render your system completely 

unreadable. 0 
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How to Turn Off Notification and System 

Sounds  

1. Click the0notification icon at the bottom right of the 

screen. You'll find it at the far edge of the toolbar next to the 

date and0time. 

2. Click the All Settings icon in the bottom right. 

3. On the0main Settings screen, choose System. 

4. In the left sidebar, choose Notifications & actions. 

5. To0completely turn off Notifications, slide the Get 

notifications from apps and other senders button to 

the Off0position. 

 

6. Or, to0be more selective with your notifications and not 

disable them all, scroll down to the Get notifications 

from these0senders section, and decide what you’re 

able to tolerate: banner, sounds, or neither from 

each option. 0 
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How to Change Your Desktop Background 

in Windows 10 

1. Click0on the Windows icon in the lower left of your 

screen next to the search bar. 

 

2. Click0on Settings in the list on the left. 
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3. Click0on Personalization, which is fourth from the 

bottom on the list. 

 

4. Click0on Background. The background page will come 

up which allows you to preview your background picture and 

lets you0choose from several photos or your own photos for 

your desktop background. 

 

5. Click0on the box underneath Background to choose 

between a picture, solid color, or slideshow for your 

background. 0 
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6. Underneath0Choose your picture, click on one of the 

options or click Browse to choose one from your 

computer. Click on whatever0photo you want and it will 

appear as your desktop background. 

7. If you don't like0the layout of the photo, you can click on 

the box0underneath. Under Choose a fit, pick 

between fill, fit, stretch, tile, or center options for your 

background. 0 

8. Once you've0made your selections, your Windows 10 

background will change automatically, no manual 

submitting0required.  

How to Change the Size of Desktop Icons 

in Windows 10 

1. Right-click0on an empty space on the desktop. 

2. Select View from the contextual menu. 
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3. Select either0Large icons, Medium icons, or Small 

icons. The default is medium icons. 

 

How to Change the Size of the Taskbar 

Icons 

If you want to0change the size of the icons in your taskbar, 

there's a different setting for that, which will also change the 

size of text,0apps, and other items across Windows 10. 

1. Right-click on an empty space on the desktop. 
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2. Select0Display settings from the contextual menu. 

 

3. Move0the slider under "Change the size of text, apps, 

and other items" to 100%, 125%, 150%, or 175%.  

 

4. Hit0Apply at the bottom of the settings 

window. Windows might ask you to log out and log back in 

for a more consistent experience. 0 

This will not0only make the icons in the taskbar a bit larger, 

but it will also make text bigger in apps like Microsoft Edge 

and Calendar, as0well as in Windows 10 notification 

windows. 
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How to Change the Size of Icons in File 

Explorer 

If you'd like larger0or smaller icons or thumbnails in 

particular folders, you can change those on the fly in File 

Explorer. 0 

Just head to0your folder location and use your mouse's scroll 

wheel to zoom in or out, effectively switching the view 

between Windows 10's0large icons, medium icons, small 

icons, list, details, tiles, and content views. 

 

Although File0Explorer will remember your last setting when 

you open this folder again, this is a folder-specific setting, so 

you'll have to0adjust each folder you'd want different icon 

and text sizes for. 

How to Give Windows 10 a Dark Theme 

Edit Themes in the Registry 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

83 
 

1. Open the0registry editor by hitting Windows + R and 

typing "regedit" in the run field. 

 

2. Navigate0 

to HKEY_LOCAL_MACHINE\SOFTWARE\Microsof

t\Windows\CurrentVersion\Themes by0opening the 

tree in the left side of the window. 

 

3. Create a new key by0right clicking in the window pane 

and selecting New -> Key 
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4. Name the0key "Personalize" and open it. 

 

5. Create a0new DWORD (32-bit) value by right 

clicking in the right pane and selecting New > DWORD (32-

bit). 

 

6. Name the0DWORD "AppsUseLightTheme". 
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7. Set the0DWORD's value to 0. To open the DWORD, 

simply double click on it. 

 

8. Navigate0 to 

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Wi

ndows\CurrentVersion\Themes\Personalize. 
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9. Create0a new DWORD (32-bit) named 

"AppsUseLightTheme". As in steps 5 and 6, you create 

the DWORD by0right clicking in the right window pane, 

selecting New > DWORD (32-bit) and typing in the name. 

 

10. Set its0value to 0. 

11. Close Regedit and reboot your PC. 

Your settings0menu should now have white text on a black 

background (as shown below). 

Setting a Dark Theme in Windows Mail 

Changing the0registry setting as shown above should also 

switch Windows 10's default Mail app to dark theme. 

However if it isn't switched0or you want to switch mail but 

leave other menus untouched, follow these steps. 

1. Launch Mail. 0 

2. Click the gear0icon in the lower left corner of the 

window to go to the settings menu. 
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3. Select0Personalization from the Settings menu. 

 

4. Select0Dark theme. 

 

Your inbox0and mailbox list should now be dark. 
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Changing Microsoft Edge to Dark Theme 

1. Launch0Microsoft Edge. 

2. Open the menu by clicking the 3-dot icon in the upper 

right corner0of the window. 

 

3. Select0Settings. 

 

4. Select0Dark from the theme pulldown. 
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The Edge0menu bar should now be white on black. 

 

Choosing a High Contrast Theme 

Many users0won't want to take it this far, but if you want the 

taskbar, Start Menu and even your window controls to have 

light text on0a dark background, you can switch Windows 10 

to a high-contrast theme. Here's how. 

1. Right click0on the desktop and select Personalize. 
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2. Select Themes0from the left pane. 

 

3. Click Theme0settings. 

 

4. Select High0Contrast #1, High Contrast #2 or High 

Contast Black. 
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Your entire desktop0and Start Menu will have light text on a 

dark background. 

 

How to Make Your Own Windows 10 

Theme 

1. Open the Start0menu and select Settings. 

 

2. Choose0Personalization from the settings screen. 
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3. Change0one or more of the following: 

 Desktop background: Select picture, solid color, or 

slideshow. In0addition to some default photos, you 

can click the Browse button to select a background 

picture. If you choose0slideshow, the default album for 

the slideshow will be the Photos folder, but you can 

browse to a different0folder and also set how often you 

want the picture to change on your desktop. 

 

 Colors: You0can either have Windows automatically 

pick an accent color from your background or select a 

color for the0Start menu tiles background and the thin 

border around windows. This will also change the color 

of the Windows0icon in the taskbar when you hover 
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over it. Optionally, you can also have that color shown 

on the taskbar0and Windows 10's action center by 

checking those checkboxes. 

 

You can also change0the Lock screen background image and 

Start menu settings here, but these aren't saved with your 

theme. 0 

4. Click0Themes in the Personalization window, then 

Theme settings. 

 

This will0open up the personalization settings in the Control 

Panel. 
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5. Right-click0on the Unsaved Theme and select Save 

theme. The Unsaved Theme appears in the My Themes 

section and contains0the the settings you just adjusted.  

 

6. Give your theme0a name in the window dialog box and 

hit OK. 
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Your new theme will be0saved and you can switch between it 

and other themes easily by going to the personalization 

options in the Control0Panel. Once your theme is saved, you 

can also right-click on it and save the theme for sharing as a 

.deskthemepack0file. 

How to Hide Your Name and Email 

Address on Windows' Login Screen 

Method 1: Edit0the Computer Policy to Hide Your User 

Information 

1. Search0for "Local Group Policy Editor" in the Windows 

taskbar and hit Enter. 

2. Navigate0to Computer Configuration > Windows Settings 

> Security Settings > Local Policies > Security0Options. 

3. Double-click "Interactive logon: Display user 

information0when the session is locked". This tells Windows 

which user0information to show on the login screen when 

your laptop0is locked. 

4. Select "Do0not display user information." 

5. Click Apply0then OK to have this go into effect 

immediately. 
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6. Next, double-click0"Interactive logon: Do not 

display last user name". This tells Windows whether or 

not to display your user info0when you boot your computer. 

7. Change the setting to0Disabled and Click OK. 

Method 2: Edit the Registry to Hide Your User 

Information0 

1. Search for "regedit" in the Windows taskbar and hit Enter. 

2. Navigate0 to 

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\C

urrentVersion\Policies\System0 

3. Double-click dontdisplaylastusername. 

4. Change the 0 to 1 in the Value0data field. 

5. Click OK. 

6. Right-click an empty area in the0right panel and select 

New > DWORD (32-bit) Value. 

8. Double-click0DontDisplayLockedUserID. 

9. Change the 0 to 3 in the Value data field. 

10. Hit OK. 0 

The next time0you log into your computer, your info will be 

hidden. To log in, you'll need to fill in both your username 

(email address or0your first and last name) and your 
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password. It's an extra step, but one many people might want 

to do for privacy or0security reasons. While you're at it, you 

can disable the lock screen in Windows 10 too and get to the 

login screen more0quickly. 

How to Add Another Column to the 

Windows Start Menu 

1. Open Settings. You0can do this from the Start menu. 

2. Click Personalization. 

 

3. Click Start in the0left menu and then toggle "Show 

more tiles" to on. 
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The Start menu will now0have an extra column of space, 

which you can drag tiles into. 

Bonus tip: If you drag the0right edge of the Start menu to the 

right, you'll get another 4 columns of tiles to rearrange and 

organize to your heart's0content. 

 

How to Restore My Computer Icon to the 

Windows 10 Desktop 

1) Right-click0on the desktop and select Personalize. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

99 
 

 

2) Click0Themes. 

 

3) Click "Go0to desktop icon settings." 

 

4) Check the0box next to Computer. You can also check 

the boxes for Control Panel, Network and User's Files to 

bring those to the0desktop. 
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5) Click0Apply. 

 

6) Click0OK. 
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7) Right-click0on This PC. 

 

8) Select0Rename. 

 

9) Type "My0Computer." 
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10) Click0Enter. 

 

How to Edit Photos to Fit Your Display in 

Windows 10 

1. Open0your image in Photos and hover over the top of 

the window with your cursor. 

2. Click0Edit. 

3. Select Lock Screen. 
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4. Adjust0the crop box by dragging it and moving 

the corner dots to select the portion you want to use 

and click0Apply. 

5. Click Save a copy. 

6. Click0the ... button. 

7. Select Set as. 

8. Select0Set as lock screen or Set as background.  

You've cropped your image to fit your display! 

How to Add Custom Accent Colors  

Add a0Custom Accent Color Using the Mixer 

If you don't have a precise color to match and just want to 

fiddle0with some controls until you get an accent shade you 

like, you can use Windows 10's color mixer. If you have the 

RGB or0Hex code for a particular color, you'll have to use the 

other method: adding custom colors to the registry. 

1. Open0the run prompt by hitting Windows + R or 

typing "Run" into the search box. 

2. Type0"Control Color" into the run box and hit Ok. 

A window appears with a list of colors. 

3. Select0the color block that is closest to what you 

want. The window title bar will change to match that color. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

104 
 

 

4. Open "Show0color mixer." 

 

5. Adjust the0Hue, Saturation and 

Brightness bars until you get a color you like. As you move 

the sliders, you will0see a preview of the color in the window 

title bar. 
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6. Click Save Changes. 

Add a Custom Accent Color Using the 

Registry 

If you have an0exact color you want to use as an accent color, 

you need to edit the Windows registry to add it. The "color 

mixer" method0described above just isn't precise enough.  

1. Open the registry editor by typing "regedit" into run 

box or the search0box and hitting Enter. 

2. Navigateto 

HKEY_LOCAL_Machine\SOFTWARE\Microsoft\Wi

ndows\CurrentVersion\Themes\ by0opening the 

folders in the left pane. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

106 
 

 

3. Create the Accents key under0Themes if it does not 

exist by right-clicking on the Theme folder and selecting New 

-> Key then renaming0the key to "Accents." 

 

4. Open the Accents0key. 
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5. Create a subkey0named "0" under Accents and 

another named "Theme0" under that. 

 

6. Create a new0DWORD (32-bit) value named 

"Color" under Theme0. You can create new DWORD values 

by right-clicking0in the right pane and selecting New -> 

DWord (32-bit) and then renaming the entry it creates. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

108 
 

 

7. Open the Color0DWORD value by double-clicking on 

it. 

 

8. Enter a color0value in ABGR (also called KML) 

format and click OK. ABGR stands for Alpha Blue Green 

Red and is composed0of hexadecimal numbers.  

9. Close Regedit and restart your computer. 

 The new color will now0appear at the bottom of the list of 

hues in the Accent color menu. 
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You can add up to seven0additional custom colors to the 

menu by creating additional theme folders under the Accents 

key in the Windows0registry. You need to name these 

Accents\0\Theme1, 0Accents\1\Theme0, Accents\1\Theme1, 

Accents\2\Theme0, \Accents\2\Theme1, Accents\3\Theme0 

and Accents\3\Theme1. 0 

 

How to Customize Windows 10's Autoplay 

Menu 

Disable Autoplay in Windows 10 

 1. Go0to Settings > Devices. 
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2. Click0AutoPlay on the sidebar. 

 

3. Switch0"Use AutoPlay for all media and 

devices" to off. 

 

Pick Specific Actions 

1. Open the0Control Panel. 

2. Choose AutoPlay. 
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From here, you0can choose different types of drives and files 

should do when you insert media into your laptop. When 

you're done, click0save. 

 

How to Install and Delete Fonts  

How to Install a0Font 

1. Download your fonts (from Google Fonts or elsewhere) 

and save them to a0folder on your hard drive. If they are in a 

.zip file, be sure to unzip them. 

2. Type "fonts" into0the Cortana search box. 
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3. Click the0Fonts control panel icon, which appears in 

the result list. 

A control panel0window filled with fonts appears. 

4. Open the0folder where you downloaded your 

uninstalled fonts. If it's your Downloads folder, you can get 

there easily by0hitting Windows + E to open Explorer and 

selecting Downloads from the left menu. 

 

5. Drag the0fonts into the control panel fonts 

window. Note that you cannot drag folders full of fonts. You 

can only select0and drag the fonts themselves. 
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How to Delete Fonts 

If you don't0want a font taking up space on your hard drive 

and in your menus, it's very easy to delete it. 

1. Open the0Fonts window. As above, you get there by 

typing "fonts" into the Windows search box and selecting 

"Fonts: control0panel." 

2. Select the font or font family you wish to delete. If you 

just want one0font, it may be listed within a "font family" 

that you have to double click to open. For example, Cambria 

Bold is located0within the Cambria family.  

3. Hit the delete key. 

4. Click0Yes when prompted with a warning. 

How to Customize the Action Center  

1. Click0the Start button. 

2. Click the Settings icon. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

114 
 

 

3. Click0System. 

 

4. Click0Notifications & Actions from the left menu. 

 

5. Drag0and drop the Action buttons. 
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6. Click0"Add or remove quick actions." 

 

7. Turn0Quick Actions on or off to hide them in the 

Action Center. 

 

You've0customized the Action Center. 
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How to Disable Transparency  

1. Launch0Settings by clicking the Start Menu and then 

Settings. 

 

2. Choose0Personalization from the list of options. 

 

3. Select0Colors from the options in the left sidebar. 
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4. Toggle0the button under Make Start, taskbar, and 

action center transparent to Off. 

 

How to Get Classic Solitaire and 

Minesweeper  

1. Download0the Windows 7 Games for Windows 10, 

Windows 8, and Windows 8.1 zip file from WinAero. 
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2. Again, scroll0past the ads prompting you to 

download, and0instead click the link near the 

Donate button. 

 

3. Click OK on0the pop-up and wait for the file to 

download. 

 

4. Double-click0to extract the files. 

 

5. Double-click the0application file. 
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6. Click Yes on the0pop-up and wait while the installer 

loads. 

7. Choose your language. 

 

8. Click0Next. 

9. Choose the games you want to install by 

checking/unchecking0the boxes next to the title. 

 

10. Click0Install. 
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How to Change Font, Text, and Theme in 

Windows 10’s Books 

1. Open0Edge.  

2. Click the star icon in the top right of the Edge 

browser. 0  

3. Select Books.  

4. Choose any0book in your library and click to open 

it.  

5. Click the double A icon in the top right. If you’re 

not seeing the0option, you’ll need to click anywhere on 

the page to bring up the header.  

6. Choose0your font from the drop-down menu.  

7. Choose from one of the three available themes: 

white,0off-white, or black.  

How to Add a URL field to Your Windows 

10 Taskbar 

1. Right0click on the Taskbar and unlock it by clicking 

the Lock the taskbar option. If this option isn’t checked, you 
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can skip0this step. It should come checked by default, 

though. 

2. Right click once more and click Toolbars > 

Address. 

3. Now, you0have a URL field in the bottom right of your 

Taskbar. To use it, simply type in a URL and press 

enter. Windows will0open the link in your default browser. 

4. To get rid of it, simply work in reverse order and 

repeat steps 20and 1. 

Add Clocks from Multiple Time Zones  

1. Open Settings0by clicking the Start menu and selecting 

it, or typing it into Cortana. 

 

2. Click on0Time & language. 
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3. Click the0Add clocks link to set up clocks in multiple 

time zones. 

 

4. Click the0option to Show this clock. This will show 

you the original clock, the one you have set to your current 

location. 0 

 

5. Next, click0the second Show this clock option, and 

set it to the timezone of your choice by selecting it from the 

drop-down0menu. 
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6. Change0the names for Clock 1 and Clock 2. 

(optional) 

 

7. Click0Apply at the bottom right. 

 

8. Click0OK. 
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How to Get the Old Volume Control UI 

1. Type0regedit in the Cortana search box and hit enter. 

2. Press the Yes button on the pop-up asking if you’d like 

to allow Registry0Editor to make changes to your machine. If 

you have User Account Control disabled, you won't have to 

do this. 0 

 

3. Navigate0 

to HKEY_LOCAL_MACHINE\Software\Microsoft\

Windows NT\CurrentVersion\. 
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4. Right0click and select New > Key. 

 

5. Name0the key MTUCVC and press enter. 

 

6. Right0click and select New > DWORD. 
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7. Name0it EnableMtcUvc and press enter. 

 

8. Right0click and select Modify. 

 

9. Set the0value to 0 and press OK. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

127 
 

 

How to Disable the Windows 10 Startup 

Delay 

1. Open0regedit. You can get there by typing regedit in the 

Cortana search bar and pressing enter. 

 

2. Click Yes0on the pop-up asking if it’s okay to make 

changes to your device. 

 

3. Find the0HKEY_Current_User folder and navigate 

to 
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Software\Microsoft\Windows\CurrentVersion\Expl

orer\Serialize. 0 

 

4. If the0Serialize folder doesn’t exist, go up one level, and 

right-click the folder for Explorer, and create a new 

key0entry named Serialize. If the folder is already there, 

you can skip this step. 

 

5. Right0click the Serialize folder and select New > 

DWORD  (32-bit) Value. 

 

6. Right0click the new value and select 

Rename. Name it StartupDelayInMSec. 
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7. Double0click the DWORD and set the value to 0. 

 

8. Press0OK. 

 

How to Add Quick Contacts to the Start 

Menu  

1. Open0the Windows Start Menu. 

2. Open the Windows 10 People app. You can find it by 

searching0"people" in the Cortana box. 
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3. Find the0contact you’d like to create a shortcut for. 

 

4. Right click0and select pin to Pin to Start. 

 

5. Click Yes, from0the pop-up window asking if you’d like to 

pin to Start. 
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6. Un-pin0contacts by right clicking their image in the 

Start Menu and selecting Unpin from Start. 

 

How to Show Hidden Files  

1. Navigate0to the control panel. In Windows 10 and 

Windows 8.1, you can get there by hitting Windows + X and 

selecting0Control Panel. In Windows 7, just click the Start 

button or hit the Windows logo key 
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2. Select0Large or Small icons from the View by menu if 

one of them is not already selected. 

 

3. Select0File Explorer Options (sometimes called 

Folder options) 0 

 

4. Open0the View tab. 

5. Select Show hidden files, folders and drives. 
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6. Uncheck0Hide protected operating system files. 

 

7. Click Yes0when prompted to confirm. 

 

8. Click0OK. 

How to Enable Spatial Sound  

One of the0coolest features of the Windows 10 Creators 

Update involves getting a better listening experience with 

premium0headphones. Spatial sound, as it’s called, gives 

headphones a sort of 3D effect or one that more closely 

resembles0true surround sound -- depending on the source. 
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Unfortunately, it’s0disabled by default. Here’s how to enable 

it. 

 

1. Right click0the sound icon in the bottom right of 

the system tray.  

 

2. Select Playback0devices from the context menu. 
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3. Click the0headphones or speaker type you’d like to 

enable spatial sound for.  

 

4. Click the0Properties button at the bottom right.   

 

5. Choose0the Spatial Sound tab at the top.   
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6. From the0dropdown menu, select Windows Sonic for 

Headphones (or other, if it’s for a speaker).  

 

How to Change the Background on the 

Windows 10 Login Screen 

1. Open the0Start menu and select the gear icon to open the 

Settings menu. 

 

2. Select0personalization from the list of options. 
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3. In the0left sidebar, find the Lock Screen option. 

 

4. Select0an image from the Windows defaults, or choose 

your own by pressing the Browse button and locating it on 

your hard0drive. 

5. You can also play a slideshow as your lockscreen 

background0by selecting it from the drop-down 

menu under Background. 

How to Repair and Restore Windows 10 

Method 1: Use Windows Startup Repair 
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1. Navigate0to the Windows 10 Advanced Startup 

Options menu.  

Once your0computer has booted, select Troubleshoot 

 

And then0you'll need to click Advanced options. 

 

2. Click0Startup Repair. 

 

Windows will take0anywhere from a few seconds to a few 

minutes to attempt to fix the problem. It may not be able to. 

If you don't actually0have a startup problem, it will also say it 

can't fix the problem. 
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Method 2: Use0Windows Restore 

1. Complete step 1 from the previous method to get to 

Windows 10's0Advanced Startup Options menu. 

2. Click System Restore. 

 

The computer0will reboot. 

3. Select your username. 

 

4. Enter your0password. 
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5. Select a0restore point from the menu and follow the 

prompts. If you have no restore points, you can't use this 

method. 0 

Method 3: Perform a Disk Scan 

Your0Windows 10 problems may stem from a corrupt file. If 

you can boot into the operating system -- even if you have to 

boot0into safe mode -- you should perform a file scan to 

check for problems.  

1. Type0"cmd" into the main search box. 

 

2. Right0click on Command Prompt and select Run 

as Administrator. 

 

3. Type0sfc /scannow at command prompt and hit 

Enter. 
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The scan0will take a while and should fix any corrupted files 

it finds. 

Method 4: Reset Windows 10 

If you want0to get a clean start, free from rogue software and 

drivers, you usually don't need to do a full install. Instead, 

Windows 100provides a built-in reset feature which takes 

your computer back to the way it was before you had any 

software, special devices0or data preloaded. On a side note, if 

you're giving your computer to someone else, resetting is a 

good way to wipe0it.  

Method 5: Reinstall Windows 10 from Scratch 

If all0else fails and you can't even reset your Windows 

computer, you can reinstall entirely. You won't even need an 

activation0number or any proof of purchase, either. Just 

make sure you have more than 4GB of space available, as 

that's how much space0the file you'll download takes up. 

Here's how to reinstall Windows 10: 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

142 
 

1. Visit this0page and click Download tool now. 

2. Click on the download link at the bottom of your 

screen. 

3. Click0Accept. 

4. Select ISO file and click Next.  

5. Select0Create installation media for another 

PC and click Next. 

6. Click0Finish. 

7. Open the Windows ISO file you downloaded. 

8. Open0Setup. 

9. Click Next. 

10. Click0Accept. Be prepared to wait a while. This next 

part may take a while. 

11. Click0Install. Again, this will take a moment while your 

system restarts. 

12. Wait0for your system to restart and install 

Windows 10. 
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How to Disable the Lock Screen  

1. Open0the registry editor. Hit CTRL + R, then type 

regedit into the prompt and hit Enter. Click Yes if you receive 

a warning0from User Account Control. 

 

2. Navigate0to 

HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Mi

crosoft\Windows by0opening the various folders in the 

tree. 

 

3. Create a new0registry key called Personalization if 

one doesn't already exist. To create the key, right click in the 

right pane, select0Key from the menu and then rename the 

key to "Personalization." 
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4. Navigate the0Personalization key. 

5. Right click in the right pane and select New then 

DWORD (32-bit) 0Value. 

 

6. Name the0new value "NoLockScreen" (without 

quotes). 
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7. Set0NoLockScreen to 1 by double clicking on its name, 

entering a "1" in the Value data field and hitting OK. 

 

How to0Disable (or Enable) Grayscale 

Mode  

1. Type0 "color filter" into the Windows search box. 

 

2. Click0"Turn color filters on or off." 

 

3. Toggle0"Turn on color filters" to On. 
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4. Pick a0filter. 

 

How0to Use Windows' Program 

Compatibility Troubleshooter 

1. In the0taskbar search box, enter run programs, then 

click "Run programs made for previous versions of 

Windows." 0 
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2. Click0Next and the troubleshooter will try to detect 

potential issues with your apps. 

3. Select0the app that's having issues in the next window 

and click Next. 

 

4. Select0a troubleshooting option: use the 

recommended compatibility setting or choose compatibility 

settings0yourself. 
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If you0choose to use the recommended settings, the 

troubleshooter will test the app using a previous version of 

Windows0so you can see if that resolves the issue. 

 

If you0choose the choose to troubleshoot the app, the 

troubleshooter will ask you which problems you're 

experiencing. Depending0on your selection, the 

troubleshooter will offer tests and suggestions to resolve the 

problem, such as testing the0display settings for the app. 
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5. Click the Test the0program button and then click 

Next. 

You can then either0choose to save the settings for the app, 

try different settings, or report the problem to Microsoft and 

view help articles0online. 

You'll have to run the troubleshooter for each app you're 

having0compatibility problems with. 

How to Run an App in Compatibility Mode 

Alternatively, you0can go into a app's properties to change its 

compatibility mode settings. With compatibility mode, you 

can force an app to0use settings from an earlier version of 

Windows -- helpful if you know the app ran well in, say, 

Windows 7 or0Vista. You can also change the display and 

color settings for the app. 

1. Right-click0on an app and select Properties. You 

can do this from the app's shortcut or by navigating in File 

Browser to the0EXE file. 
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2. Select the Compatibility tab, then check the box 

next to "Run0this program in compatibility mode 

for:" 

 

3. Select the0version of Windows to use for your app's 

settings in the dropdown box. 

 

4. Hit Apply, then0run your app and see if this fixed your 

issues. 
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How to Enter0the BIOS on a Windows 10 

PC 

1.  Navigate to0settings. You can get there by clicking the 

gear icon on the Start menu. 

2. Select Update0& security. 

3. Select Recovery from the left menu. 

4. Click Restart0Now under Advanced startup. The 

computer will reboot to a special menu. 

5. Click0Troubleshoot. 

6. Click Advanced options. 

7. Select0UEFI Firmware Settings. If you don't see this 

icon, then press Startup Settings, instead. When your PC is 

restarting,0tap F1 (or F2) to access the BIOS. 

8. Click Restart. 

Your system0will restart and take you to the BIOS. 

How to Disable Web Results in Windows 

10 Search 

1. Select0the search box in Windows 10's taskbar. 

Cortana's greeting and news feed results should appear. 
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2. Click0the notebook icon  in the left pane. It's directly 

under the home (aka house) icon. 

4. Click0Settings. A menu of Cortana options appears. 

5. Toggle "Cortana can give you suggestions . . .” to 

off. 

6. Toggle0"Search online and include web results" to 

off. 

The0searchbox will now say "Search Windows" instead of 

"Ask me anything." It will be more responsive and only show 

results from0your hard drive or local network. 

How to Disable App Notifications  

1. Click0the Action Center icon in the System Tray. 

 

2. Right-click0a notification.  
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3. Select "Turn0off notifications for this app". 

 

That application can0no longer send notification messages to 

your desktop. 

How to Fix a0Slow-Opening Windows 

Downloads Folder 

1. Open File0Explorer. You can get there by hitting 

Windows Key + E or clicking on the explorer icon in your 

taskbar. 0 

2. Right0click on the Downloads shortcut in the right 

window pane and select Properties. 

3. Navigate0to the Customize tab. 
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4. Select "General items" from the "Optimize this folder 

for:"0list. 

5. Click Ok. 

How0to Turn Off Personalized Ads in Your 

Browser and Microsoft Account 

1. Navigate0to https://choice.microsoft.com in your 

web browser. 

2. Toggle0off "Personalized ads in this browser". This 

forces Microsoft to show generic ads when you're on sites like 

MSN.com,0Outlook.com, Bing search, and other Microsoft-

related sites and partners, including those owned by AOL. 

3. Toggle0off "Personalized ads wherever I use my 

Microsoft account." This disables personalized ads for any 

site or app0you sign on with your Microsoft account, such as 

Xbox, Windows, and Windows phone. 

Turn Off Personalized Ads in Windows 

Apps 

If you don't0want to see personalized ads in Windows apps 

or Windows devices (even if you're not signed in with a 

Microsoft account): 0 
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1. Open0Settings. You can do this from the Start menu in 

Windows. 

2. Click0on Privacy. 

3. Turn off "Let apps use my advertising ID for 

experiences0across apps." 

How to Clear the Run Command's History 

in Windows 10 

1. Open the0Registry Editor. You can get there by hitting 

Windows + R, typing in "regedit" and hitting Enter. 

 

2. Navigate0 to 

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Wi

ndows\CurrentVersion\RunMRU. You can get there by 

opening folders0in the left pane. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

156 
 

 

3. Select and0delete the command entries in the 

right pane. You can remove them by either hitting the 

delete key or right-clicking0and selecting delete. Do NOT 

delete the entry named "MRUList" Each command is stored 

with a letter name (a, b, c). 0 

 

4. Close the Registry Editor. 

How To Disable Cortana  

1. Open0regedit the registry editor, from the search box on 

the taskbar. 

2. Goto0 

HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Mi
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crosoft\Windows\WindowsSearch 

But wait!0Windows Search might not be there. It wasn't for 

us, so we had to create it. 

2a. Right-click0the Windows folder and choose 

New>Key. Call it "Windows Search." 

 

3.  Right0click "Windows Search" and choose New > 

DWORD (32-bit Value). 

 

4. Name0the DWORD "AllowCortana." Click it 

and make sure the value is "0." 
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5. Restart0the computer (or log out and log back in). 

Cortana will be replaced with a regular search bar. 

How to0Uninstall and Restore Windows 

10’s Built-in Apps 

Before you0uninstall or restore apps, make sure no other 

programs are running aside from Windows PowerShell. 

1. Click the0Cortana search field. 

 

2. Type0'Powershell' into the field. 
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3. Right-click0'Windows PowerShell.'  

 

1. Select Run0as administrator. 

 

5. Click0Yes.  
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6. Enter a command from the below list for the 

program0you wish to uninstall. 

7. Click Enter. Repeat steps 6 and 7 as necessary for the 

apps you want0to remove.  

 

How to0Restore Windows 10's Built-in Apps 

1. Follow steps 1 through 5 in the previous 

walkthrough. 0 

2. Type the below text and then hit Enter.  

 

You've restored the0apps you've deleted! 
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Battery0Icon Missing in Windows 10? 

Here's How to Restore It 

1.  Right click0on the taskbar and select Settings. 

 

2. Click "Turn0system icons on or off." 

 

 

Your battery icon0should appear in the system tray again. 
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How to Fix0a 'Boot Configuration Data File 

is Missing' Error in Windows 10 

1. Insert your0installation media into the computer. 

 

2. Boot to the0media. We had to press F12 during bootup 

on the Dell we fixed up to reach this menu, though these keys 

can differ depending0on your laptop's make and model. 

3. Click Next on the Windows Setup menu. 

4. Click "Repair your0computer." 

5. Choose Troubleshoot. 

6. Select "Advanced0options." 

7. Pick "Command Prompt." 
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8. Type Bootrec /fixmbr0and press the enter key. 

9. Type Bootrec /fixboot and press the enter key. 

10. Type Bootrec /scanos0and press the enter key. 

11. Type Bootrec /rebuildbcd and press the enter key. 

12. Type "A" to add the0installation to the boot list and hit 

enter. 

13. Exit the command0prompt with the X button on the 

top of the window. 

14. Click "Continue" to0go to your desktop. 

How to Get to Windows 10's Advanced 

Startup0Options Menu 

Method 1: Hit F11 

On many computers, if0you hit F11 as soon as the computer 

powers on, you can get to the Advanced Startup Options 

menu. 0 

Method 2: Boot off of an Install Disk 

If you0have an install disk on USB or DVD, you can boot off 

of it and get into the Advanced Startup Options menu that 

way. 

1. Create0a bootable Windows 10 install disk if you 

don't have one already.  
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2. Boot off0of the disk. You may need to hit a button on 

your laptop to tell it to boot off of removable media. 

3. Click0Next. 

4. Click Repair Your Computer. 

5. Click0Troubleshoot. 

Method 3: Wait for Your Computer to Take You There 

If Windows010 encounters a startup error, it may eventually 

take you to the Advanced Startup Options menu on boot. 

Method 4: Hit0Restart with Shift Key Down 

If you can make it to the Windows 10 login screen, you can 

get to the Advanced0System Options menu. 

1. Click the power button icon in the lower right corner. 

2. Hold down0shift and click Restart. 

3. Click Troubleshoot on the screen which appears. 

4. Click0Advanced Options 

Method 5: Use the Settings Menu 

If you are0already at the Windows 10 desktop, getting to the 

Advanced Startup Options menu is easy. 

1. Navigate0to settings.  You can get there by hitting the 

gear icon on the Start menu. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

165 
 

2. Click Update0& security. 

3. Select Recovery from the menu. 

4. Click Restart0Now. 

The computer will boot to an options menu. 

5. Click0Troubleshoot. 

6. Click Advanced Options 

How to0Delete a Locked File in Windows 

10 

1. Locate the folder you wish to delete. I don’t have any 

locked folders I’m0willing to delete, so let’s create an 

unlocked folder -- and call it SkypeHost.exe (a copy of an 

actual locked file) -- for the sake0of the tutorial. It works the 

same, but you can just as easily remove this folder with the 

delete button. 

2. Download0Process Explorer from Microsoft’s 

website, and press OK on the pop-up window. 
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3. Double click0processexp64 to extract the file. 

 

4. Choose Extract0All. 

 

5. Click0Open. 

 

2. Double0click the procexp64 application to open the 

application. 
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7. Select0Run. 

 

8. Read0the terms and press the Agree button. 

 

9. In the0Process Explorer window, choose File > Show 

Details for All Processes. 
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10. Allow0the app to make changes by pressing the 

Yes button. 

 

11. Go the0the Find menu at the top and select Find 

Handle or DLL. 

 

12. Type in0the file name and hit Search. 

 

13. Right0click the process in the bottom of the 

Process Explorer screen and select Close Handle. If 

there are0multiple processes listed here, you’ll need to repeat 

this step to close all of them. 
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14. Delete0the file as you would normally. 

 

How0to Restart Windows 10 Without 

Rebooting 

1. Right0click the Start menu or press CTRL + Alt + 

Delete. 

 

2. Select0Task Manager. <manager.png> 
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3. Find0Windows Explorer in the list of processes. 

 

4. Right0click and select Restart. 

 

How to0Roll Back the Windows 10 

Creators Update to a Prior Version 

1. To get0started, click Start and then Settings. 
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2. Click0on Update & security. 

 

3. In the0sidebar, choose Recovery. 

 

4. Click0the Get Started link under Go back to the 

previous version of Windows 
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5. Select0why you’d like to go back to a previous 

build and click Next. If the link is grayed out, you didn’t 

select a reason from0the checkboxes above. 

6. Click Next once more after reading the prompt. 

How0to Disable Automatic Driver 

Downloads  

1. Right click0the Start button and select Control 

Panel. 

 

2. Make your0way to System and Security. 

 

3. Click0System. 
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4. Click0Advanced system settings from the left sidebar. 

5. Select the Hardware tab. 

6. Press0the Device Installation Settings button. 

7. Choose No, and then press the Save Changes button. 

How0to Completely Disable Internet 

Explorer  

1. Right click0the Start icon and select Control Panel. 

 

2. Click0Programs. 
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4. Choose0Programs & Features. 

 

4. In the left0sidebar, select Turn Windows features on 

or off. 

 

6. Uncheck0the box next to Internet Explorer 11. 
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6. Select Yes from0the pop-up dialogue. 

 

7. Press0OK.  

 

How0to Find What's Draining Your 

Windows 10 Laptop's Battery 

1. Click the0Start button. 

 

2. Select0Settings. 
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5. Click0System. 

 

4. Select0Battery saver. 

5. Select Battery use to see how your battery usage breaks 

down, app0by app. If you want to limit background activity 

for all apps, turn0the Battery saver switch to the On position. 
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6. Select an0app. At the top of this screen, you can see how 

your battery usage is split between System, Display and Wi-

Fi. If Display has0an especially large percentage, you will 

need to lower your0brightness setting to regain battery life. 

 

7. Click0Details. 

 

8. Turn0the "Allow this app to run in the 

background" switch to the off position so it will eat less 

of your0battery life. 
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Now0you're more informed about which apps drain your 

battery, and how to rein them in. Best of luck keeping your 

battery's0charge filled. 

How to0Disable the Windows 10 Password 

Prompt on Wake from Sleep 

1. Navigate0to the Settings menu. You can get there by 

clicking the gear icon on the Start menu. 

 

2. Select0Accounts 
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3. Click0Sign-in Options in the left pane. 

4. Select0Never from Require sign-in the menu. 

 

How to Turn On 'Hey Cortana'  

1. Click the0search box to the right of the Start button. A 

Cortana dialog0box appears. 
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2. Click the0menu icon in the upper right corner of 

Cortana's window. It has three stripes. 

3. Select0Notebook. 

4. Select Settings. 

 

5. Toggle0"Let Cortana respond to 'Hey Cortana.'" to 

On. 

Now the0next time you say "Hey Cortana" into your 

microphone, you can follow that with a command such as 

"what's the0weather like?" and get some results. If you just 

say "Hey Cortana," the assistant will ask "what would you like 

me to do." 0  
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How0to Enable or Disable Cortana Access 

on the Lock Screen 

1. Select0the Ask me anything field. 

 

2. Select0the Gear icon. 

3. Turn Lock Screen on or off.  It may already be 

enabled. If you turn0it off, skip the remaining steps. 

 

4. Check "Let0Cortana access my calendar, 

email..." if  you want the digital assistant to be able to send 

emails, book appointments0or send SMS messages from the 

lock screen. This could be a security risk if a bad actor gets 

access to your computer while0you're away. 
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5. Enable Hey0Cortana if you want to launch Cortana 

from the lock screen with your voice. If you'd prefer to launch 

the assistant with an0icon tap, see below. Either way, you're 

going to end up talking to your computer, however. 

 

How to0Enable Trappable Cortana on the 

Lock Screen 

If you're prefer0to invoke Cortana by tapping an icon, rather 

than saying "Hey Cortana," here's how. 

1. Select the0Ask me anything field. 

 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

183 
 

2. Select the0Gear icon. 

3. Turn "Hey Cortana" on or off. 

 

4. Click Lock0screen settings.  

 

5. Click0Windows spotlight. 

 

6. Select0Picture or Slideshow. 
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How0To Set a Timed Reminder With 

Cortana 

1. Activate0Cortana or select the "the "Ask me 

anything" field  

2. Write0or say "remind me to [activity] in 

[timeframe]" or "[timeframe] remind me to [activity]." For 

example, you0could say "in an hour, remind me to get 

lunch." 

If Cortana did not process your request exactly as you'd like, 

tap on the0reminder, day, or time fields, and then edit their 

contents to make sure the correct reminder is set. 

If you want0the reminder to recur, click on "Only once."  

The reminder can chime in every day, or on specific days of 

the0week. 

3. Click Remind once you're satisfied with the terms you've 

set.  

You0won't forget it this time! 
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How to Enable A Contact-Based Reminder 

1. Type0a reminder in the "Ask me anything" prompt that 

reminds you to tell one of your contacts something. 0 

 

2. Select "Remind" if it's ready or edit the fields if 

something0is incorrect or incomplete. If Cortana does not 

recognize the name or you have more than one contact with 

that name, you'll0be asked to choose from a list or browse 

your contacts. Cortana will confirm the reminder. 

The reminder will0pop up when you next communicate with 

that person. If you want to see all of your reminders, click the 

Lightbulb button0in the Cortana menu. 

How To0Find A Group of Photos You 

Took With Cortana 

1. Type your0search request into the Cortana Search 

Box, asking it to show you a specific kind of file, and name 

the day or time0window you used it.  
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2. Select0the "Show me..." option that "Search photos" 

under it. 

 

Cortana's0found the photos you were looking for, so you can 

look back at the simpler and more decadent times. 

How to0Use Cortana to Find the Last File 

You Opened 

1. Type your request into the Cortana Search Box, 

specifying0that you're looking for the last file you opened.  

 

2. Select0the "Show me" option that has "Search 

documents" under it. 
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There's that0file you were just using, and the directory it can 

be found in is0listed as well.  

 

How to0Find Your Presentations with 

Cortana 

1. Ask Cortana0to show you your presentation files. 

 

2. Select the0"show me" option that has "Search 

documents" underneath it. 
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How to Turn0On and Use Cortana in Microsoft Edge 

To turn her on in Edge, follow these steps: 

1. Open Edge0 

 

2. Click the0More button in the top right (the one with 

the three dots). 

3. Click0Settings at the bottom of the More window. 
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4. Scroll down and hit the button that says “View 

Advanced0Settings.” 

5. Click the slider underneath where it says “Have Cortana 

assist me in0Microsoft Edge.” 

How to Change Cortana's Voice and 

0Language in Windows 10 

1. Navigate to Settings. You can get there by clicking the 

Settings Icon0on the start menu 

 

2. Click Time0& language. 

 

3. Select Region0& language from the left pane. 
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4. Select a new0region from the pulldown menu. As of 

this writing, Cortana is only available in the United State, 

United Kingdom, Italy,0France, Spain, Germany and China. 

If you want to0give Cortana a British accent, select "United 

Kingdom." 

 

5. Click0Add a language under the Languages subhead. 

 

6. Select0the appropriate language. The top-level menu 

only shows major language groups, but you'll get to pick a 
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specific0dialect on the next screen. So, for British English, 

you select "English" from this menu. 

 

7. Select0the local dialect for the language. For British 

English, for example, you would select "English (United 

Kingdom)." 0 

 

8. Click the0language you just added. 

 

9. Hit "Set0as default." 
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The new0language will now be at the top of the list. 

10. Select the language again and hit Options. 

 

11. Click0the Download buttons under "Download 

language pack" and "Speech." Wait for both to install. It 

could take a0few minutes and you may have to click the 

button again to restart one of them if it gives you a message 

that it0failed. 

 

12. Click0Settings under Speech. 
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13. Select0the new language from the Speech language 

menu. 

 

14. Check "Recognize non-native accents . . . " That 

should help0improve speech recognition, particularly if you 

are an American but using the British English Cortana. 

15. Restart your0computer. 

Next time you launch Cortana, you will be asked to set the 

voice assistant up by0giving it your name, just as would for 

any language. 

16. Change your0keyboard if you still want the standard 

U.S. QWERTY layout. The British layout is similar but moves 
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some important0symbols around (ex: the @ sign is no longer 

on the 2 key). To change your keyboard, click the button to 

the left of0your system clock and select "US 

Keyboard" from the menu that appears. The keyboard 

button will be0labeled as "ENG," "ESP" or some other 

abbreviation that represents the currently-selected keyboard. 

Change0the Date Format, Location 

When you change the region and language, you not only 

change Cortana's0voice but also set the date and time so that 

it appears the way it would for that country. For example, 

changing to0United Kingdom makes the time display in a 24-

hour clock and formats the date with as day / month / year. 

If you want to0use U.S. date formatting instead, follow these 

steps. 

1. Search for0"Region" in the Cortana / Search box 

and click "Region Ccontrol Panel" in the results. 

2. Select "English0(United States)" from the Format 

menu. 

3. Click0Ok. 

How to0Change the Name Cortana Calls 

You in Windows 10 

1. Click0on "Ask me anything" in the lower left corner. 
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2. Select the Notebook icon. 

3. Click0on "About Me" 

4. Select "Change my name" 

5. Type0your name of choice into the prompt. 

6. Click0Enter. 

7. Select "Hear how I'll say it" to confirm that Cortana 

will speak it0correctly. If Cortana says it incorrectly, click 

"That's wrong," and you'll be given the option to say the 

name aloud. 

8. Once0you approve of how Cortana says your name, select 

"Sounds good."  

Cortana0now knows your name, until you want to change it 

again. 

How0to Shut Down Windows 10 with a 

Cortana Voice Command 

To create the0shut down shortcut: 

1. In0Windows Explorer, navigate to: C:\Users\[User 

Name]\AppData\Roaming\Microsoft\Windows\Star

t Menu\Programs. 0 

2. Right-click on an0empty space in the right pane 

and select New > Shortcut. 
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3. In the location0field, enter "shutdown.exe -s" (without 

the quotes) 

If you don't want0the computer to shut down immediately 

add a space after the -s and then "-t 60". This will set a timer 

for the system to shut0down in 60 seconds, and you can 

replace 60 with any number. 

4. Click0Next. 

5. Leave0the shortcut name default, "shutdown.exe" 

and click Finish. 

To shut0down your computer with Cortana: 

1. Click the microphone button on the Search bar or 

say "Hey0Cortana." 

2. Say "Open shutdown.exe" or "Open shut down 

EXE"0 

From0now on, you can use Cortana to shut down your 

computer with this voice command. 

How0to Find Your Phone With Cortana 

1. Select the Cortana box on your Windows 10 desktop.  

2. Type0"ring my phone" or "find my phone."  
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Alternatively, you could ask Cortana with your voice by 

clicking on0the microphone icon and speaking one of those 

phrases. 

3. Select the0icon that matches the phrase you 

entered. Make sure it says "I can help with this" under the 

icon or you may end up0with a search result set or third-

party app instead. 

Your phone0will start ringing. 

4. Tap the "Stop Ringing" button on your phone to stop 

the0buzzing. 

How to See the List of Apps Cortana Can 

Integrate With 

1. Click0"Ask me anything" in the taskbar to wake 

Cortana up. 

2. Click0the question mark button. Cortana will list 

some tasks it can do. 

3. Scroll0down to see the list of Cortana-enabled 

apps. You'll also see a suggestion for what you can do with 

Cortana and0those apps. 

4. Click the app to see more suggestions. 
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5. Click the0microphone or type in the Cortana "Ask 

me anything box" to enter the name of the app and the 

command, such0as "Netflix, find House of Cards." 

In addition to Netflix, Cortana also works with Fitbit and 

Uber, so you can0say "Fitbit, I ate a bagel for breakfast" or 

"Uber, get me a ride." You can also have Cortana open third-

party apps as well0as default Windows programs, like File 

Explorer, on Windows 10. 

How to Make0Cortana Show the Weather 

for Multiple Cities 

1. Click in the "Ask0me anything" field in the taskbar to 

open0Cortana. 

2. Click the ellipsis (three dots) next to your location and 

weather0forecast. 

3. Click "Edit in Notebook." 

4. Scroll0down and click "Add a city." 

5. Type in a city name to search for it.  

6. Check0the box next to "Notify me about weather 

incidents" if you want to get breaking news alerts related to 

that city's0weather. 

7. Click the Add button. 
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Whenever0you open Cortana, you'll see the forecast for both 

your current location and any additional cities you've added. 

Click the0down arrow to see more weather details for that 

location, right in your taskbar. 

How to0Send SMS Messages With Cortana 

on Windows 10 

Setup0on Android 

1. Download Cortana for0Android from the Google Play 

Store0to your phone. 

2. Tap0the hamburger menu in the top right-hand 

corner. 

3, Tap Settings. 

4. Select0"Sync Notifications." 

5. Turn on "Missed call notifications," "Incoming 

message0notifications," and "App notifications 

sync." 

Setup on Windows 10 

1. Click0Settings in Cortana. 

2. Turn on "Send notifications between devices." 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

200 
 

Send an SMS 

Activate0Cortana. 

1. Either say "Text [NAME]" or type "SMS 

[NAME]," to start0sending an SMS. You can only SMS 

people in your contacts in Windows 10. 

2.  Dictate0or type your message. 

3.  Say or click "Send." 

Respond0to Incoming Text Messages 

When you receive a text message, you'll now get a Windows 

10 alert notification. You0can type your reply directly in a 

text field that appears in the notification window. 

How to Restrict Cortana's Ever-Present 

Listening  

1. Go to0Settings > Privacy. 

2. Change your privacy options to decide what data 

to send to0Microsoft. This doesn't affect Cortana, but you 

might as well do it while you're here. 

3. Go0to "Speech, inking & typing" in the left rail. 

4. Click "Stop getting to know me."  

5. Click0"Turn off." 
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Clear Cortana's Existing Data 

1. Open0settings in Cortana. 

Here you can also decide if you want Cortana to listen for you 

to say0"Hey Cortana," both on the desktop or the lock screen. 

2. Scroll all the way to the bottom and click Clear. 

If you0use Cortana again after clearing your data, you'll need 

to come back here to erase it again. 

 Hiding0Cortana 

1. Right-click on the taskbar. 

2. Choose0Cortana > Hidden. 

Cortana will disappear from the taskbar. If you have it set to 

answer to0"Hey Cortana," it will reappear with the voice 

command. Alternatively, you can still use the Cortana app 

from the start0menu. If you want Cortana back in the 

taskbar, right click the taskbar again and select "Show search 

box." 

How to0Create Cortana Reminders with 

Windows 10 Sticky Notes 

 1. Open the0Windows Ink Workspace from the 

taskbar. 

 2. Select Sticky Notes. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

202 
 

3. Write your0reminder note, and be sure to include a 

date or time. 

You can use a0stylus and write your reminder or type it with 

the keyboard. If you write, you may have to try multiple times 

if you have0messy handwriting. 

4. Tap the time or date when it turns blue. 

5. Tap0"Add Reminder." 

6. Correct any errors and click Remind. 

7. Cortana0will confirm the reminder and alert you prior to 

the event.  

How0to Make Cortana to Send News 

Notifications in Windows 10 

1. Click the0Cortana field of the Taskbar. 

2. Click the Notebook icon. 

3. Under0"News topics you're tracking" click "+ Add 

a topic." 

4. Enter a0topic into the prompt. 

5. Select a result. 

6. Click0Add. 
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How to Mirror Your Screen in Windows 10 

1. Open0the Start menu on your Windows 10 

machine. 

From0here, you can just search for Connected Device 

Settings in the Start menu's search field to skip a few 

steps. If not, read0on. 

2. Click on Settings. 

3. Select0Devices. 

4. Choose Connected Devices. 

5. Click0Add a Device. 

6. Select your WiDi receiver. 

7. Select0Remove Device. 

8. Click Yes. 

How to0Cut Your Windows 10 PC's Boot 

Time by 66 Percent 

1. Click the0Start button. 

2. Type "Power Options." 

3. Select0Power Options. 

4. Click "Choose what the power button does." 

5. Select0"Change settings that are currently 

unavailable" if the Shutdown settings are greyed out. 
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6. Check0the box next to "Turn on fast startup."  

7. Click Save Changes. 

How to0Calibrate Your Monitor in 

Windows 10 

1. Right-click on0the desktop and select Display 

settings 

2. Click "Advanced0display settings" at the bottom of 

the settings window. 

3. Verify that0your monitor is set to the 

recommended, native resolution. If it's not, set it to the 

recommended0resolution at least for this calibration process. 

4. Click "Color calibration" at the bottom of the advanced 

display settings0window. 

5. Click Next to start the color calibration. 

The wizard will0walk you through adjusting your color 

settings. You'll: 

Set the display0to the factory default color settings, if your 

monitor allows you to do that 

Adjust your0display's gamma to match a sample image 

Adjust the brightness and contrast 
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Adjust the0color balance6. At the end of the 

wizard, click Finish to save your settings. 

Screen0Mirroring on Windows 10: How to 

Turn Your PC into a Wireless Display 

1. Open0the action center. It's represented by the speech 

bubble icon in the lower right corner of the screen. 

2. Click0Connect. 

3. Click Projecting to this PC. 

4. Select0"Available Everywhere" or "Available 

everywhere on secure networks" from the top pulldown 

menu.  

5. Select0"First time only" or "Every time" under "Ask to 

project to this PC." I recommend picking "first time only," 

unless you're0really worried that some rogue person is going 

to grab your phone and project to your computer without 

your permission. 0  

6. Click Yes0when Windows 10 alerts you that another 

device wants to project to your computer. 
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How to0Mirror Your Windows 10 Screen 

to Another Windows 10 Device 

Here's how0to broadcast your screen from the sending 

device, if it's a Windows 10 computer. Android devices have 

different wireless display0menus. 

1. Open the action center. 

2. Click0Connect. A list of available receiving devices 

appears and your other computer should be on it. 

3. Select0the receiving device. You may have to wait a 

minute or longer for the devices to pair. It may also fail and 

you'll need0to try again. 

4. Toggle "Allow input" to on if you want to let the 

receiving0device control your PC with its keyboard and 

mouse. 

5. Click0"Change projection mode" and select 

"Extend" from the menu that appears if you want to use the 

wireless0display as a second desktop, rather than a mirror of 

your current desktop. 

6. Click0Disconnect when you want to terminate your 

connection. 
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How to0Make Your Windows 10 Laptop 

Last Longer on a Charge 

Here's how to0make your Window's 10 laptop battery last 

longer on a charge: 

Decrease the0Screen Brightness 

The most visible source of battery drain is your display's 

backlight, which0sucks up more power than anything else in 

most notebooks (perhaps with the exception of a GPU in a 

gaming notebook). A0few percentage points of luminosity 

can go a long way. 

Battery Saver0Mode 

Windows 10's Action Center features an easy way to turn on 

the operating0system's battery-saver mode, which restricts 

background activity and push notifications. To turn on the 

mode: 0 

 Open0the Action Center 

 Click the Battery saver button 

You can0fine-tune Battery saver in Settings > System > 

Battery. The setting gives you options that allow you to 

decide when to0turn on the mode automatically (it defaults 
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to 20 percent), and whether you want to automatically lower 

your screen0brightness when it activates. 

Sleep More 

Just like0people, Windows 10 laptops can stay awake longer 

if they sleep more. So set your laptop to put itself to sleep 

when you're not0using it. 

To decide when your computer should sleep: 

 Select0Power Options from the control panel. 

 In the menu next to “Put the computer to sleep, pick a 

time.” The0default time interval is 15 minutes, but you 

should pick a shorter time so that your laptop goes to 

sleep after0only a few minutes of not being used. You 

can also pick a shorter time interval for the display to 

shut itself0off. 

Change Wi-Fi Networks 

We run the Laptop0Mag Battery Test on an 802.11ac Wi-Fi 

network. Connecting to a 5-GHz connection rather than an 

older, 2.4-GHz0connection can save your laptop's battery 

life, since 802.11ac networks use less power. It's a quick way 

to increase your0internet speeds as well as your battery life 

Turn Off Backlit Keyboards 
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Backlit0keyboards look nice, but they are huge battery sucks. 

If you're a touch typist and you're sitting in a dark room, 

you'll have no0problem turning off the backlight function, 

and you'll reap some benefits in terms of battery life. You can 

usually turn off0backlighting by hitting the Function (FN) 

key and pressing a backlight key on the top row of your 

keyboard (some0computers may not require you to hit the 

function key). 

Use a0High-Contrast Theme 

They're not pretty, but Windows 10's high-contrast themes 

can save some0energy. They use black pixels, with white and 

yellow text, which is far more energy-efficient than bright 

white0background. These themes are meant to help make it 

easier for you to see the display, but this is a nice benefit on 

the0side. 

To turn on a high-contrast theme: 

- Go0to Settings > Appearance and Personalization > Change 

the Theme 

- Pick0High Contrast #1, #2 or Black (the white high-

contrast mode won't help). 

The Edge0and Firefox browsers will automatically adapt to 

the high-contrast theme. Upon opening Chrome, you will be 
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offered0the opportunity to download a high-contrast 

extension. 

Turn0on Airplane Mode 

Airplane mode will shut off your Windows 10 laptop's 

wireless radios, which0will disable Bluetooth and Wi-Fi. It's 

a quick way to save some electricity, as long as you can get 

your work done locally. Most0laptops have a function key 

assigned to this, but you can also open the Action Center and 

turn on Airplane mode0there. 

If you need Wi-Fi, you can still turn off Bluetooth from the 

Action0Center. 

Remove Peripherals, Hard Drives and Discs 

Anything0you have attached to your laptop is sucking a little 

bit of power. Whether you're syncing a phone, backing up 

your data or0have a disc you just burned sitting in your DVD 

drive (yes, some people still have those), they all require 

power. Disconnect0all of your extras to save a little juice. 

Limit Background Programs 

You could have0programs running in the background that 

you don't even know about. Often, this is because these 

programs are set to launch0when you boot up your laptop. 
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To see what runs at startup, go Task Manager > Startup. This 

tab is filled with0programs that could be connecting to the 

internet, even when you didn't start them up yourself. If 

there's any app0running automatically in the background 

that you don't need, click Disable to remove it from this list" 

Rein in Antivirus 

You may have0your antivirus software set to automatically 

scan your laptop at the same time each week. That's a good 

idea, as it helps0you keep your computer clean. But if the 

scans run while you're on battery power, you could lose quite 

a bit of juice. Depending0on your antivirus program, you 

may be able to delay scheduled scans until you've plugged in 

your notebook. Alternatively, you0should pick a time when 

you're likely to be near a wall socket. 

How to Use Multiple0Desktops in 

Windows 10 

1. Click the Task View icon0in the taskbar. It looks like 

two overlapping windows. Alternatively, use the 

Windows+Tab keyboard shortcut to go into0Task View. 

2. Click the New desktop button in the Task View.  

Windows will create an0additional virtual desktop you can 

switch to with the Windows+Tab keyboard shortcut. 
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Once your additional0desktop is created, you can open new 

program windows in it. You can also drag a window from one 

desktop to another, and0switch to the other desktop with the 

Windows+Tab keyboard shortcut. 

Other shortcuts that will0make using multiple virtual 

desktops easier: 

WIN +0CTRL + LEFT/RIGHT: Switch to the previous or 

next desktop 

WIN0+ CTRL + D: Create a new desktop 

WIN + CTRL + F4: Close the current desktop 

How0to Import Gmail Contacts to 

Windows 10 

1. Open0the People app. 

2. Click "Add accounts." 

3. Choose0Google. 

4. Log in with your Google account. 

5. Click0Allow. 

6. Click Done. 

Your0contacts will populate the People app. You can follow 

these same steps for iCloud or Outlook. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

213 
 

How0to Record Video of an App in 

Windows 10 

1. Open the0app you want to record. Unfortunately, the 

tool can't capture some programs, such as File Manager, or 

the entire desktop, but0it does work in regular apps, whether 

from the Windows Store or desktop apps. 

2. Press the Windows0key and the letter G at the 

same time to open the Game Bar dialog. 

3. Check the "Yes, this0is a game" checkbox to load the 

Game Bar. This is the procedure whether you are recording a 

game or another kind of0app. 

4. Click on the Start Recording button (or Win + Alt + 

R) to begin capturing0video. 

5. Stop the recording by clicking on the red recording 

bar that will be on0the top right of the program window. (If 

it disappears on you, press Win + G again to bring the Game 

Bar back.) 0 

Note that0you can also use the Xbox recording tool to take 

screenshots. Instead of clicking the recording button, click 

the camera icon0on the Game Bar or Win+Alt+PrtScn. 
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How to Enable the Linux Bash Shell  

1. Navigate0to Settings. You can get there by clicking the 

gear icon on the Start menu. 

2. Click0Update & security. 

3. Select For Developers in the left column. 

4. Select0Developer Mode under "Use developer 

features" if it's not already enabled. 

5. Navigate0to the Control Panel (the old Windows 

control panel). You can get there by hitting Windows Key + X 

and selecting0Control panel from the pop-up menu that 

appears. 

6. Select0Programs and Features. If it's not visible, 

make sure you select "Large icons" from the "View by" menu. 

7. Click0"Turn Windows features on or off." 

8. Toggle "Windows Subsystem for Linux" to 

on and0click Ok. 

9. Click the Restart Now button. 

10. Search0for Bash in the Cortana / Search box and click 

its icon. 
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11. Type "y"0 and hit Enter when promoted to install 

Ubuntu. The system will then take a few minutes to install 

Ubuntu in the0command prompt window. 

12. Create a username and password. 

How0to Use the Parental Controls  

To use Windows' parental controls, you'll need two things: 

You have to log into0Windows with your Microsoft account 

(not a local account) and the account you want to manage has 

to be set up as a child0account in Windows. With Windows 

10, your child will also have to use a Microsoft account to log 

in. This is a change from0previous versions of Windows, but 

it allows you to apply the parental control settings across all 

the Windows devices0your child uses and manage the 

settings from the web. If your child doesn't have a Microsoft 

account or an email address,0Windows 10 will prompt you to 

create one when you set up the child account. 
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Log0onto Microsoft Family and Review 

Your Child's Computer Activity 

1. Sign in 

 to0https://account.microsoft.com/family#/ with your 

Microsoft account. A link to this page is also available under 

your0Accounts settings (in the Settings app, Accounts > 

Family & other users). 

 

2. Click0your child's name. 

3. Review and adjust the Activity reporting 

settings on the main0account page for your child. Activity 

reporting and weekly email reports are on by default. You can 

uncheck or toggle these0settings off and also view your 

child's web browsing activity and apps usage on this page. 
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4. Block0specific sites or apps your child has 

previously accessed by clicking the "Block" link next to 

them. For0URL blocking and web browsing reporting to 

work, your child will need to use Microsoft Edge or Internet 

Explorer, so0you'd have to block Chrome and other browsers 

if you want these features. 

Adjust0Parental Control Settings 

From here, you can navigate to one of the parental control 

settings using the0dropdown box at the top of the page (it 

currently says "Recent activity"). 
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Here's what you0can change for web browsing, apps and 

games, screen time, purchases, and Xbox privacy settings: 

Web Browsing Settings 

1. Toggle0inappropriate content blocking off or 

on. Adult content is blocked by default. You can change that 

setting if0you want here. 

 

2. Add0URLs for any websites you want to allow your child 

to always be able to access or always want to block. 
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Apps,0Games & Media Settings 

1. Allow or don't allow kids to download mature 

apps and0games. By default, inappropriate apps and games 

(e.g., mature movies and games) are blocked. 

 

2. Select the0appropriate age ratings for apps, games, 

and media from the Windows Store with the age dropdown 

box. 0 

 

Screen Time Settings 

1. Turn0on time limits. These are off by default. 

2. Choose the times your child can use the 

computer. For0each day, you can set a start and end time, 
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as well as a time limit (e.g., 4 hours on Saturdays but 2 hours 

on weekdays. You0can also block access all day). If the child 

exceeds the time limits or it's not within your set timeframes, 

a warning will0popup and require an adult to log in to regain 

access to the computer. 

Purchase0& Spending Settings 

1. Review your child's spending in the Store. This page 

shows your child's0purchase history with the Microsoft Store 

and the Xbox store. 

2. Add money to0your child's Microsoft account. If 

you want to allow your child to make some purchases--

without racking up thousands0on virtual coins--you can add 

money to his or her Microsoft account and keep your credit 

card out of it. 0 

How to Add a Child or Adult User in 

Windows 10 

1. Navigate0to Settings. You can get there from the 

Start menu. 
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2. Click0Accounts. 

 

3. Click0Family & Other Users in the left window pane. 

 

4. Click "Add0a family member" or "Add someone 

else to this PC." Choose "family member" if you are either 

adding a child or0adding an adult who needs access to 

parental control settings for child users. If no children are 

using this0computer, using "Add someone else . . " should be 

fine. 
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Follow the0instructions below, based on what type of user 

you wish to add. 

To0Add Another Adult User 

1. Click "Add someone else to this PC." 

2. Enter the0person's email address and click Next. 

This address should be tied to the person's Microsoft 

account.  

3. Click0Finish. 

If you want this user to be able to install desktop software or 

change0settings, follow the instructions below to make them 

an administrator. 

To0Give a User Admin Permissions 

If you want one of your adult users, whether they are a parent 

or not, to be0able to install desktop software, change settings 

or add other users, you will need to give them admin 

permissions. Here's0how. 

1. Open control panel. You can get there by hitting 

Windows + X and0selecting control panel. 
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2. Open the User0Accounts menu. 

3. Click Manage another account. 

4. Select the0account you wish to give admin rights to. 

5. Click "Change the account type." 

6. Select0Administrator and click the Change 

Account Type button. 

To Add a Child 

1. Click0"Add a Family Member." 

2. Select "Add a Child."  

3.Enter0the child's Microsoft account email 

address. If they don't have a Microsoft account, you must 

sign them0up for one. If your child is too young to have an 

email address and you click "The person I want to add 

doesn't have an0email address," you will be prompted to 

create a Microsoft account and corresponding @outlook.com 

email address0for them. It's unfortunate that Microsoft 

requires child accounts to have email, but parents can use 

their own email0address or create a dummy one. 

4. Click Confirm. 

5. Click0Close. The child's email account will get an invite. 

6. Have the child click Accept on the email. 
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The0child may be prompted to log in to their account. If the 

Microsoft account lists your child as being under  13, a parent 

will0need to sign in and confirm them as a family member. 

 

If you0grant the child permission, you will be asked for a 

credit card number to verify that you're actually an adult. So 

you might0be better off just creating a dummy Microsoft 

account for your child and registering with Microsoft for 

them.  

7. Click0"Manage family settings online" in the 

Windows 10 account settings menu. 
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Your browser0will open to the Microsoft website where you 

can manage all of your family members' access. 

8. Select the0child whose permissions you wish to manage. 

 

9. Use the0controls to set restrictions on what sites 

your child can see, what apps they can use and how long they 

can use the0computer. By default, you will also get weekly 

activity reports mailed to you. 

 

To Add a Parent 

A parent0is like any other adult user, but they also have the 

right to manage the child settings. 

1. Click0"Add a Family Member." 

2. Select Adult, enter the email address and click 

Next. The0email account should be tied to the new user's 

Microsoft account. 
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3. Click0Confirm. 

 

The person0will receive an email invitation and have to 

confirm it. 

 

How to0find your MAC Address in 

Windows 10 

What is a MAC address? 
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A MAC address is0a unique, alphanumeric hardware 

identifier for a device that connects to the internet. Every 

network device or0interface, such as your laptop's Wi-Fi 

adapter, has a MAC (or "media access control") address.  

Method 1: How0to Find Your MAC Address in 

Windows 10 with Command Prompt 

The quickest way0to find the MAC address is through the 

command prompt. 

1. Open the0command prompt. Search "Command 

Prompt" in the taskbar, or if you have an older version of 

Windows, you0can right-click on the Start button and select 

Command Prompt from the menu. 

 

2. Type in0ipconfig /all and press Enter. This 

will display your network configuration.  
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3. Find your0adapter's physical address. Scroll down 

to your network adapter and look for the values next to 

"Physical Address," which0is your MAC address. 

Method 2: How to Find Your MAC Address in 

Windows 10 in0the Network Connection Settings 

You can also find the MAC address by looking at the details 

of your network adapter0in Windows. 

1. Search "View network status and tasks" in the 

taskbar and click0on it. (Or navigate to Control Panel > 

Network and Internet > Network and Sharing Center) 

 

2. Click on your0network connection. 

3. Click the "Details" button. 
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4. Locate the0Physical Address. The value for the 

physical address in the Network Connection Details window 

is your MAC0address. 

Method 3: How to get your MAC address by 

accessing0your taskbar 

Another avenue that you can use to find your device's MAC 

address is by0clicking on an icon on your taskbar to quickly 

navigate to your PC's hardware identifier. 

1. Click on0the network icon on your Windows 10 

taskbar. It should be next to the clock. 

2. Click on0"Properties" on your connection. This will 

open your0network's settings window. 

3. Scroll down to the Properties section. Your MAC 

address0should be right next to the words "Physical 

address." 

How To Lock a Folder With a Password  

1. Right-click0inside the folder where the files you want 

to protect are located.  

The folder you0want to hide can even be on your desktop. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

230 
 

 

2. Select "New" from0the contextual menu.  

 

3. Click on "Text0Document." 

 

4. Hit Enter. It0doesn't matter what the file will be named. 

You can delete this text file once the lockable folder has been 

made. 0 
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5. Double-click0the text file to open it. 

 

6. Paste the0below text into the new document: 

7. Find where it says "Your-Password-Here" in the 

document. 0 

9. Click File. 

10. "Select0Save As..." 

11. Click0on the "Text Documents (*.txt)" menu 

bar that's next to "Save as type:" 

12. Select0"All Files" 

13. Change the file name to "FolderLocker.bat" 

14. Click0"Save." 
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15. Double-click FolderLocker. 

16. Fill the0Locker folder with the items you want to 

protect. 

17. Open the0FolderLocker file, because it's time to lock that 

folder up! 

18. Type "Y"0into the screen. 

19. Click Enter, and the Folder Locker window will 

disappear, along0with the Locker folder itself! Your secrets 

are safe! 

To unlock the0folder, double-click "FolderLocker" to open it. 

 

Enter the0password you entered in Step 8, and click Enter. 
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The Locker0folder is back. You can open it to find your 

hidden files. Repeat Steps 17, 18 and 19 to lock the folder 

again. 

 

How to0Set Up Windows Hello Fingerprint 

Login 

Here's how0to set up Windows Hello fingerprint logins: 

1. Go to Settings > Accounts. 

2. Scroll to0Windows Hello and click Set Up in the 

Fingerprint section. 

If you don't have0a PIN, you'll need to create one to set up 

the fingerprint reader. 

3. Click Get0Started. 

4. Enter your PIN. 
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5. Scan your0finger on the fingerprint reader. 

You will have to do this multiple times to give the scanner a 

good picture of0your prints. 

6. Click Add Another if you want to repeat the process 

with another finger, or0close the program. 

How to Set Up Windows Hello Facial 

0Recognition 

 1. Open Settings and choose Accounts. 

2. Click "Sign-in0options" on the sidebar and scroll down 

to Windows Hello. Click "Set up" under Face. 

If you don't have a0PIN, you'll need to set that up first. That's 

located directly above Windows Hello. 

3. Click Get0Started. 

4. Enter your PIN. 

5. Stare into0the webcam while Windows Hello scans 

your face. This procedure will be quick.  

6. Click Improve0Recognition for additional scans, or 

close the setup process. If you wear glasses or a hat, we 

recommend that you0scan your face with and without them 

on. 
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The next time you log0in to Windows, the camera will be 

searching for your face. 

How to0Automatically Lock Your 

Windows 10 PC with Dynamic Lock 

1. On your0PC, click the gear icon in the Start Menu 

and select settings. 

 

2. Click0Devices. 

 

3. After0ensuring Bluetooth is first toggled on, click the + 

button for Add Bluetooth or other device. 
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4. Click0the Bluetooth icon. 

 

5. Click0the appropriate device, and then wait for the 

PC and mobile phone to pair. You may have to accept a 

prompt or0two to complete the pairing process, depending 

your phone. 

 

6. Click the0back button in the Settings menu and 

select Accounts. 

 

7. Select Sign-in0options from the left panel. 
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8. Scroll down to0Dynamic Lock, and check the box 

for Allow Windows to detect when you’re away and 

automatically lock0the device. 

How to Find Saved Wi-Fi Passwords  

1. From the Windows0System Tray, right-click the Wi-Fi 

icon and Open Network and Sharing Center. 

2. Click on0Connections: (your Wi-Fi network 

name) to open the Wi-Fi Status Window. 

3. Click Wireless0Properties. 

4. Switch to the Security tab. 

5. Under Network0security key, check the box that says 

Show characters. 

How to0Set Up a Metered Internet 

Connection  

1. Open the start0menu and select Settings. 

 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

238 
 

 

2. Click the0Network and Internet link. 

3. Select Wi-Fi from the sidebar. 

4. Click the0Manage known network link under your 

existing connection. 

5. Choose the0network you’re currently using from 

the list of available ones. 

6. Click0Properties. 

7. Find the Metered connection section and toggle the 

switch0to On. 

How to Set Up and Use Find My Device  

1. Tap0on the Windows icon to open the Start menu. 

2. Select Settings. 

3. Tap0Update & security. 

4. Select Find My Device. If you don’t see this option, tap 

on Windows0Update, select Check For Updates and install 

all available updates. 
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5. Tap0Change. If this box is greyed out, tap on "Turn on 

location settings to use this feature," and enable location 

settings0in the following menu. 

 

6. Switch0"Save my device’s location periodically" 

on. 

 

How0to Use Find My Device to Track 

a Missing Windows 10 Device 

1. Visit0https://account.microsoft.com/devices on 

any computer, and select Sign In. 
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2. Sign0in with your Microsoft Account name and 

password. 

3. Select0Find My Device. 

 

And now0you’ve found that missing 

computer! Unfortunately, Find My Device doesn’t let you 

ping, lock or erase your device, but we0hope to see those 

features added in a future update.  
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How0to Stream Xbox One Games to 

Windows 10 

1. Ensure0that game streaming is enabled on the 

Xbox One. 

In order to0do this, access Settings, then Preferences, and 

make sure that the box marked "Allow game streaming to 

other devices0(beta)" is checked off. 

2. Plug your Xbox One (or Xbox 360) controller into 

your0computer. 

This will install the drivers for your controller to your 

computer. Once0the controller vibrates, you're ready to use 

it. Keep in mind that you do have to keep it hooked up while 

you play, as the0Xbox One uses wireless protocols not readily 

available on Windows 10. It's also worth noting that you can 

use Xbox0360 controllers to play any streamed Xbox One 

games on your PC, whether you prefer the feel of your older 

pad or have0a specialty controller, such as a fight stick, that 

wouldn't normally work with Xbox One. 

3. Open the0Xbox app on Windows 10. 

The Xbox app comes built in to Windows 10. Either open it 

from the Start0menu or simply search for it in the command 

bar. Keep in mind that you will have to be signed in to the 
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same Microsoft0account on both the Xbox One and Windows 

10 for streaming to work properly. 

 

4. Select0Connect on the app. 

Connect is the second option from the bottom on the left 

hand side of the0screen. 

5. Click Connect in the upper-right to choose your 

Xbox One0 

6. Click on Stream. 

Your game0should now be streaming to your computer. 

Streaming0Xbox One games comes with a few caveats. 

Generally speaking, the process works only with games; you 

can't broadcast0content from streaming apps, since it's 

protected, and Microsoft is not allowed to rebroadcast it. 

Depending on your0wireless setup, you may also want to 

adjust the video quality. By default, the Xbox One streams to 

Windows 10 at0Medium quality, which Microsoft describes 

as being suitable for 5GHz wireless networks when the 
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console and receiving0PC are in different rooms. You can 

also set the quality to High if both devices are hardwired into 

the same router, or Low0if you have a low-end computer. 

(High, Medium and Low do not appear to correspond to any 

hard-and-fast0video qualities, but rather to a general sense 

of how smooth the game looks overall. In our tests, they all 

worked fine on0a 5GHz wireless connection with both 

devices in the same room.) 

That's all there0is to it. Next, perhaps Microsoft will give 

users a way to access games while on a remote network, thus 

ending once and for0all any possibility of getting actual work 

done on business trips. 

How to Map a Network Drive  

1. Open0File Explorer and select This PC. 

2. Click the Map network drive drop-down in the 

ribbon menu at0the top, then select "Map network 

drive." (This is under the Computer tab, which should open 

automatically when you0go to This PC, as above.) 
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3. Select0the drive letter you want to use for the 

network folder, then hit Browse. 

4. If you0receive an error message, then you'll need to turn 

on network discovery. To do so, open the Control Panel, 

select Network0and Sharing Center and choose 

Change advanced sharing settings from the top-left 

corner. From there, select Turn0on network discovery. 

Save changes. 

5. Navigate to the folder you want to map and hit 

OK after selecting0it. 

6. Confirm your selection and click Finish. You can 

choose to0reconnect to the folder every time you sign in so 

it's always available. You can even use a different user 

account to connect to0the folder if needed. 

7. When you're done, you should see the new drive letter 

under This PC and0will be able to access its contents like you 
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would any other folder. If you want to disconnect the 

network drive, right-click0on it and select Disconnect. 

How to Create Limited-Privilege User 

Accounts  

1. Tap the Windows0icon. 

2. Select Settings. 

3. Tap0Accounts. 

4. Select Family & other users. 

5. Tap0"Add someone else to this PC." 

 

6. Select0"I don't have this person's sign-in information." 

7. Select "Add a user without a Microsoft account." 

8. Enter a0username, type the account's password twice, 

enter a clue and select Next. 

9. Tap the0Windows icon. 

10. Select the User icon at the upper left corner of the Start 

menu. 0 
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11. Select0the new user. You'll then sign into your account 

with your password from step 8. 

How0to Set Time Limits for Any Account  

1. Press0Windows+X to open the Power User Menu and 

select Command Prompt (Admin). 

2. Enter0the following command: net user <username> 

/times:<days,times> 

 Replace0<username> with the user account you want 

to set time limits for. You can get a list of users on the 

computer0by typing in net user and pressing Enter. 

 Replace <limits> with the days and times the user 

would be0allowed to use the computer. Days are represented 

as M, T, W, Th, F, Sa, or Su. Times are in 24-hour format. So, 

for0example, you could limit usage on Tuesday from 9am to 

5pm by entering /times:T,09:00-17:00. Separate multiple 

time0limits with a semicolon, e.g.: /times:M-F,09:00-

17:00;Sa-Sun,09:00-15:00 

3. Press0Enter. 

Once you set the time limit, the user won't be able to sign 

into the computer0outside of that set time frame. To remove 

the time limits for an account, type in net user <username> 

/time:all and0press Enter. 
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How to Pin Contacts to the Windows 10 

Taskbar 

1. Type People0into the Cortana search bar and click the 

first result to open. 

 

2. Find the0contact you’d like to add to the Taskbar, 

and right click to open a pop-up window. 

 

3. Select Pin0to Taskbar. 

 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

248 
 

4. Choose Pin from0the pop-up window to add the contact 

to your Taskbar. 

 

5. Click the0contact’s name or image from the Taskbar, 

and message, Skype, or edit their contact information 

from the0Taskbar. 

How to Open a Port on Windows Firewall 

1. Type0Firewall in the search box on the taskbar, clicking 

the Windows Defender Firewall to open it. 

 

2. Click0Advanced Settings from the left sidebar in the 

next window. 
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3. In the0left pane, click Inbound Rule. 

 

4. In the0right pane, click New Rule. 

 

5. Select0Port under What type of rule would you like to 

create? 
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6. Click0Next. 

7. Type a port number for Specific local ports. 

8. Click0Next. 

9. Select Allow the connection. 

10. Click0Next. 

11. Select any network type you are OK to allow the 

connection0over. 

12. Click Next. 

13. Type a0name for the rule. 

14. Click Finish. 

How to0Uninstall Default Windows 10 

Apps 

1. Open Settings from the Start menu. 

3. Click0on Storage and then in the right 

pane select your C: drive.2. Click System. 
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4. Click0on Apps & features. 

5. Click on an app and then the Uninstall button to uninstall 

the0app. 

Turn Off Hibernation 

When0you hibernate your computer, Windows saves your 

computer's current state--your open documents and 

programs--to0your storage drive so you can resume your 

work when you turn the computer back on. If you don't use 

hibernation0mode, you can disable it and get rid of the 

hiberfil.sys file, which takes up several gigabytes of storage 

space. 0 

1. Open a Command Prompt in Administrator 

Mode by0right-clicking on the Windows Start button and 

choosing Command Prompt (Admin). 

2. Click Yes0if User Account Control asks whether to allow 

the Command Prompt to open. 

3. In the0Command Prompt window, type in powercfg -h 

off and hit Enter. 

Change0the Virtual Memory Size in Windows 10 

With virtual memory, if your computer doesn't have enough 

physical0memory to run a program or operation, Windows 

will temporarily move some data from RAM to a paging file 
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on your hard0drive. You can limit how much space this 

paging file takes up. 

1. Open the0Control Panel. You can do this by searching 

for it on the taskbar or start menu. 

2. Click System0and Security. 

3. Click System. 

4. Click on0Advanced system settings in the left menu. 

5. Go to the Advanced tab and click the Settings 

button under0the Performance section. 

6. Go to the Advanced tab and click the Change… 

button in the0Virtual memory section. 

7. Uncheck the box next to "Automatically 

manage paging0file size for all drives". 

8. Select the "Custom size" option and enter the initial and 

max sizes you wish0to let the file grow to. Hit Set and then 

OK to finish. 

How to Delete the Windows.old Folder 

 Deleting the0Windows.old folder involves three basic 

actions: 

1. Search for and open the "Free up space..." utility. 

2. Click0Cleanup System Files. 

3. Check Previous Windows Installations. 
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Step-by-Step0Instructions with Screenshots 

1. Type "Free up disk space" into the Windows 

search box. 0 

 

2. Click the shortcut for "Free up disk space . . ." 

3. Click0OK. Change the drive if your Windows disk is not 

already selected.  

4. Click0Clean up system files. 

5. Click0OK again when the drive letter is displayed. The 

Disk Cleanup window will appear again. 

6. Check0"Previews Windows installation(s)" in the 

Files to delete box and Click OK. 

7. Click0Delete Files when asked to confirm. 

8. Click Yes when prompted to confirm your decision. 

The software0will take anywhere from 30 seconds to several 

minutes to delete the files. 
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How to0Back Up Files with File History  

How to Set Up File History 

1. Search0for "file history" from the taskbar and 

click on "File History settings." 

 

2. Click0"Add a drive" in the Settings app. 
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3. Select0your drive or network location.  

 

To choose0a network location, scroll down and click "Show 

all network locations" to find the shared location. 

 

4. Click0"More options" to customize File History. 

 

Here you'll0be able to change how frequently backups will 

run, how long they'll be kept, choose the folders to be backed 

up, exclude0folders from the backup, or switch to a different 

drive. 
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How0to Restore a File with File History 

To get an important file or folder back: 

1. Search0for "restore files" from the 

taskbar and click on "Restore your files with File 

History." 

2. Navigate0to the file or folder to restore. If you want 

to restore a previous version of a file, use the arrows to see 

earlier versions0of it. 

3. Click the Restore button to save it in its original 

location. You0can save it to a different location by right-

clicking on the file then selecting "Restore to" and choosing a 

new0location. 

Use0Disk Cleanup to Delete Old Updates 

from the SxS Folder 

1. Open0the Disk Cleanup tool. You can do this by typing 

"disk cleanup" in the taskbar and clicking "Disk Cleanup" 

 

2. Click0the "Cleanup system files" button. 
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4. Click0OK. 

Note that0if you don't see the Windows Update Cleanup 

option in Disk Cleanup that means there aren't any files that 

can be0safely deleted. 

Use the Command Prompt to Clean Up the 

SxS Folder 

If you0want a more thorough view of how much space the 

SxS folder is taking up and the option to clean up unneeded 

files, use the0Command Prompt. 

1. Launch the command prompt with admin 

priviledges. You0can do this by right-clicking on the 

Windows icon in the taskbar and click "Command Prompt 

(Admin)." 0 

2. Enter0the command: Dism.exe /online /Cleanup-

Image /StartComponentCleanup 
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3. If0recommended, clean up the folder using this 

command in the Command Prompt: Dism.exe 

/online /Cleanup-Image /StartComponentCleanup0 

How to Mount and Burn ISO  

Microsoft and other companies often distribute0software as 

an ISO file, an exact copy of a DVD. In Windows 8 and 

Windows 10, you can easily work with these0files without 

needing third-party software. Here's how to mount the ISO 

image so you can see the contents and burn0it to a physical 

disc so you can install the software on any computer. 

 

How to Mount and Unmount an ISO File in Windows 

Mounting0or opening an ISO file is as simple as double- 

clicking on0it, thanks to Windows' built-in ISO-handling 

capabilities. In Windows 7 and earlier, you'd need to use a 

utility like0Virtual Clone Drive to mount an ISO. 
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When you double-click on an ISO file in Windows 8 and 

above, however, it0opens to show you the contents, just as if 

you were browsing a CD or DVD. 

 

In fact, it shows up0as a virtual DVD drive and is assigned a 

drive letter. You can open and copy individual files and 

folders from the ISO once it's0mounted. 

 

When you no longer0need to work with the ISO, here's how 

to unmount it: Right-click on the drive and select Eject. 
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How to Burn an ISO file to Disc 

Creating a disc of the0ISO contents, whether as a backup or 

to install the software on other computers, is a cinch too. 

1. Insert a blank0CD or DVD in your writable optical 

drive. 

2. Right-click on the ISO file and select "Burn disk 

image." 

3. Select "Verify0disc after burning" to make sure the 

ISO was burned0without any errors. 

4. Click Burn. 

That's it! Windows0Disc Image Burner will do its thing and 

let you know when it's finished. 

How to Format0an External Drive in OS X 

1. Connect the drive to the Mac. 

2. Open Disk Utility. The0easiest way to do that is hit 

CMD and the spacebar at the same time and type in Disk 

Utility to find the0program. 

3. Select the drive you want to format. 

4. Click0Erase. 
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If you don't plan on using the drive for Time Machine, skip 

steps 5 to011 below and continue with step 12. 

5. Give the drive a descriptive name and leave the 

default settings: OS0X Extended format and GUID partition 

map. These will format the drive in OS X's HFS+ filetype so it 

will be compatible0with Time Machine. 

6. Click Erase and OS X will format the drive. 

7. With the drive0selected in Disk Utility, click Partition. 

8. Enter the amount of space you want to set aside 

for Time Machine. In0this example, we're shrinking the 

Time Machine partition to 128 GB instead of allowing Time 

Machine to take up the whole0drive. 

9. Click Apply. 

10. Select the new0untitled partition so we can format it 

as exFAT for use with both Mac and Windows. 

11. Click0Erase. 

12. Give the partition a name and select exFAT for 

the format. 0 

13. Click Erase to finish. 

Your0exFAT-formatted drive or partition can now be used 

for both Windows and Mac. Note that using a drive 
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frequently between0Windows and Mac could increase the 

chances of file corruption, so make sure you have backups of 

the files on the shared drive0and be extra careful about safely 

ejecting the drive before0disconnecting it from your 

computer. 

How to Format an External Drive in 

0Windows 

1. Connect the drive to0your Windows PC. 

2. Open the Disk Management tool. You can do that by 

typing "disk format" or "disk0management" in Windows 

search or going to Control Panel > Administrative Tools > 

Create and format hard disk0partitions. 

3. Right-click on the external drive's partition or 

unallocated space you0want to format and choose New 

Simple Volume… 

4. Follow the wizard0to choose a volume size. 

5. Assign a drive letter. 

6. Choose exFAT as0the file system in the Format 

Partition screen. 

7. Give the volume a0new name. 

8. Click Next. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

263 
 

9. Click Finish. 0 

Windows will format0the drive as exFAT and you'll be able to 

use the drive on both Windows and Mac. 

How to0Zip a File or Folder  

Zip Files Using the Send To Menu 

We'll use the context0menu to quickly zip files or folders. 

1. Select the file(s) and/or folder(s) you want to 

compress. If you0want to zip just one file or folder, skip to 

step 2. Otherwise, there are two ways to select multiple files 

and folders: 0 

To select a0consecutive group of files or folders, click the first 

item, then hold down the Shift key and click on the last item. 

The two0files/folders you selected and everything in between 

will be selected. 

 To select0non-consecutive files or folders, hold down the 

Ctrl key as you select the individual files and/or folders. 

2. Right-click0on the file or folder (or group of files or 

folders), then point to Send to and select 

Compressed (zipped) 0folder. 

3. Name the ZIP file. Enter the name you want the zipped 

file to have or hit Enter to0accept the suggested filename. 
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Zip One or More Files with the Ribbon Menu 

The File Explorer in0Windows 10 has a Zip command in the 

Ribbon menu. This is convenient for 2-in-1 laptop owners 

who might prefer to tap to0zip files rather than right-click. 

To use this:  

1. Select your file(s) 0and/or folder(s) as in Step 1 in 

the Send To menu instructions above. 

2. Navigate to the0Share tab in File Explorer. 

3. Click the Zip button. 

Add a File or Folder0to an Existing ZIP File 

Finally, you can add files and folders to an existing ZIP file 

simply by selecting the0ones you'd like to add then dragging 

them on top of the ZIP file. 

Hard Drive Full? Here's0How to Save Space  

I. Search for Large, Unnecessary Files 

You may have files hiding in0the depths of your storage drive 

that you don’t need, but which is taking up huge amounts of 

space. These could be log0files, temporary files or 

installation apps for programs you've already installed. 

 Here's how to find your largest0files. 

1. Open File Explorer (aka Windows Explorer). 
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2. Select "This0PC" in the left pane so you can search your 

whole computer. If you only want to look at your C drive, 

select the C drive0instead. 

3. Type "size: " into the search box and select 

Gigantic. 

You may have to0wait a few minutes for File Explorer to 

search your whole drive. Wait until the status bar finishes 

filling the0top. 

4. Select "details" from the View tab. 

5. Click0the Size column to sort by largest to smallest. 

6. Look through your list of files and delete those you 

no longer0need. If you're in doubt about what a file does, 

leave it be or look it up. The last thing you want to do is break 

a program or0erase important data. ISO files, Program 

installers and temp files are often things you can get rid of. 

7. Navigate to0the Downloads folder. It's usually in 

your Quick Access toolbar. 

8. Delete any0downloads you no longer need.  

II. Use the Disk Cleanup App 

Windows 10's0buit-in Disk Cleanup program finds and 

deletes unnecessary files that the operating system no longer 

needs. Here's how to0use it. 
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1. Launch Disk Cleanup. You can find it by searching in 

the search0box. 

2. Select Your C drive and click OK.  

You'll0have to wait a moment while it scans your drive. 

3. Check off all the types of files you want to delete if 

they0aren't already selected. They can all be safely removed, 

but some, like the temporary Internet files that make up your 

browser0cache, may serve a purpose. Temporary files are 

often a particularly large waste of space. 

4. Click0Ok. 

5. Click Delete Files to confirm. 

7. Select0C drive again. 

8. Check off all the listed files (if they aren't already 

checked)0and click Ok. Note that that command erases 

Downloaded program files and Temporary Internet files so if 

you want0to keep those, uncheck them 

III. Disable Hibernation 

By0default, your laptop is set to allow hibernation, a state of 

deep sleep where the contents of your RAM are saved to the 

hard0drive rather than using power in the memory chips 

them. 
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Unfortunately, for0hibernate to work, the system has to keep 

a large system file called hiberfil.sys that eats up several 

gigabytes, even0when the computer is powered on. If you're 

willing to live without hibernation mode, you can save the 

space. 0 

1. Open a Command prompt as administrator. You can 

get there by0typing cmd into the search box, right-clicking 

the result and selecting "Run as administrator." 

2. Type0powercfg /hibernate off at the prompt and hit 

Enter... 

How to Free Disk Space Automatically 

with Windows 10 Storage Sense 

A new0feature in Windows 10’s Creators Update has your 

back. 

1. Right0click the Windows icon at the bottom right of 

the screen and open the System menu. 

2. Select0Storage from the sidebar at the left. 

3. Toggle Storage Sense to the on position. 

4. If you’d0like to determine what Storage sense deletes 

(either files in the Recycle Bin or temp files -- or both), click 

the Change0how we free up space link below the 

toggle. 
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5. Toggle on, or0off the desired settings. 

How0to Install Windows 10 Apps to an 

External or Second Drive 

1. Click the0Start menu to and select the gear icon (settings). 

 

2. Choose0System from the settings menu. 

 

3. Select0Storage from the sidebar. 

 

4. Use the0New apps will save to dropdown menu to select 

your external drive. 
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How to0Add the Control Panel to Windows 

10 File Explorer 

1. Open0the Registry Editor by clicking the Start button 

and typing “regedit.” 

2. Hit0Enter, or click the appropriate match in the Best 

match section. 

3. Click0the Yes button to allow Registry Editor to make 

changes to your device. 

4. Navigate0to the following key: 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\

Windows\CurrentVersion\Explorer\MyComputer\N

ameSpace0 

5. From0here, we’re going to create a new key inside the 

NameSpace key. Right-click the NameSpace 

key and0choose New > Key. 

6. Depending0on the name we give the key, Control panel 

can open in either category view or icon view. Right click 

the New Key and0name it one of the following: 
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How0to Disable Quick Access from 

Windows 10 File Explorer 

1. Right0click the Start menu and select File 

Explorer from the list of options. 

2. Click0the View tab. 

3. Click0Options and then Change folder and search 

options. 

4. In the0General tab, use the dropdown menu next to Open 

File Explorer to: to change the selection from Quick 

Access to0This PC. 

5. Click Apply at the bottom right to save the change. 

6. Click OK0to close the Window. 

7. Close File Explorer. 

How0to Hide the Navigation Pane in 

Windows 10 File Explorer 

1. Right0click the Start menu and choose File 

Explorer from the available options. 

2. Click0the View tab atop the File Explorer ribbon to 

open your view options. The Navigation pane is on the left by 

default, but0we’re going to hide it.  
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3. At the left, select Navigation pane, and then click 

Navigation0pane from the dropdown to remove the 

checkmark. From here, you’ve just disabled the left sidebar 

and moved the0content over ever-so-slightly. 

4. To show the Navigation pane, simply repeat steps one 

through three, this0time ensuring the Navigation pane 

gets a check mark after clicking. If so, you should see the 

Navigation0pane. 

How to Pin Windows 10 File Explorer 

0searches to the Start Menu 

To start, you’ll0need to have some saved searches. If you 

haven’t saved any searches, it’s pretty simple to get started. 

Simply search for0anything in File Explorer, and click the 

Save Search icon in the ribbon. If you aren’t seeing the 

ribbon, click the carrot on0the right side to reveal it. 

1. Open the File Explorer by right-clicking the Start Menu 

and selecting0it. 

2. Navigate to your Users folder. 

3. Click the0appropriate User folder. 

4. Select Searches. 

5. Right0click the appropriate saved search and select 

Pin to Start. 
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How to0Star Rate Your Files in Windows 

10 (and Why You'd Want to) 

1. Right-click0an photo or video. 

2. Select Properties. 

3. Click the0Details tab. 

4. Click a star0to apply a rating. The fifth star from the 

left is a 5-star0rating, the 4th is a 4-star rating and so on. 

5. Click OK. 

6. In0Explorer, click in the search field and write 

"Rating:" and select a number of stars. 

How0to Share Files Straight from 

Windows 10 File Explorer 

 

Configuring0the Send to options 

1. Press the0Windows key + R to launch the Run menu, 

or type Run into Cortana’s search field and press enter.  

2. Type0shell:sendto and press Enter to open a folder 

containing shortcuts that show up in the Send to menu. 

3. To0delete an app, just right click it and select Delete. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

273 
 

4. To add an app that you’d like to use to share things, 

just0drag it into the window (it has to be downloaded 

from the Windows app store). 

Sending Files 

5.  Right0click any file or folder on your computer 

and select the application you’d like to use to send the 

file. 

How0to Find (and Remove) Duplicate 

Files  

1. Open CCleaner. 

 

2. Select0Tools from the left sidebar. 

 

3. Choose0Duplicate Finder. 
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4. For most0users, running the scan with the default 

selections is fine. You can, however, alter these searches 

by checking0or unchecking the provided boxes, and 

selecting new sizes in the drop-down menus. 

 

5. Choose0the drive or folder you want to scan. 

 

6. Click0the Search button to start the scan. 
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7. Select0the files you’d like to remove (carefully). Once 

you complete the next step, there’s no turning back. These 

files are0gone. 

 

8. Click0the Delete Selected button to finish the 

operation. 

 

How0to Take Ownership of a Folder in 

Windows 10 Using File Explorer 

Here's how0to take ownership and get full access to files and 

folders in Windows 10. 
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1. Right-click0on a file or folder. 

 

2. Select0Properties. 

 

3. Click the0Security tab. 

 

4. Click0Advanced. 

5. Click "Change" next to the owner name. 
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6. Click0Advanced. 

7. Click Find Now. 

 

8. Select0your username and click OK. 

9. Click OK. 

10. Click0Apply. If you're modifying a folder, you 

might want to  

11. Click0OK. 

12. Click Add. Now it's time to make sure you have all kinds 

of0permissions. 

13. Click Select a principal. 

14. Click0Advanced. 

15. Click Find Now. 

16. Select0your user name and click OK. 
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17. Click0OK. 

 

 

19. Click0OK. 

 

20. Click0OK. 
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21. Click0your user name, it's time to verify your new 

permissions.  

 

22. Click0OK, as you've taken ownership and full 

permissions0for the folder!  
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How To0Turn Off Annoying File Explorer 

Ads in Windows 10 

1. Open0File Explorer and go to View > Options > 

Change folder and search options. 

 

2. Choose the0View tab in the "Folder Options" window. 

3. Uncheck "Show sync provider notifications" in the 

advanced settings0list. It's towards the bottom. 

How to Rotate and Resize Objects in Paint 

3D 

from the welcome0screen. 

1. Click the paintbrush icon in the top menu bar 

and select03D shapes. It’s the 3D-looking box icon 

in the dropdown. 

2. Choose any0of the shapes in the right sidebar 

and then click and drag on the canvas to place it. 

Shapes are found0under the 3D objects section, but 3D 

models are placed the same way. 3D doodles require 

you to actually draw the0shape first. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

281 
 

3. To rotate images, grab any of the half or semi-

circle icons found0on the right, top, and 

bottom sides. 

4. To resize, drag any0of the boxes in the corners 

(or middle). These are the small boxes on the 

outermost edges of the0shape. 

How to Create 3D Text in Paint 3D 

1. Open Paint 3D and click0New to start a new project. 

 

2. Select0text tool from the menu bar at the top, or just 

press “T” on0your keyboard. 

 

3. Select the0three dimensional icon from the 

sidebar (3D text). From here, you can also choose a 

different font from the menu0right below, or (moving down 
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and to the right) size, color, bold, italics, underline, as well as 

alignment (left, right,0center). 

 

4. Click0anywhere on the canvas and start typing. 

 

5. Click0anywhere on the canvas outside of the text 

box to turn it 3D. 

 

6. Grab0any of the corners of the text box to change 

the size, or any of the four circles to change orientation, 

angle, and depth. 0 
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How to Crop the Background Out of an 

0Image in Paint 3D 

1. Open Paint 3D0and click New to create a new document. 

2. Click the folder icon in the upper left corner to bring up the 

settings0menu. 

3. Choose Insert. 

4. Select0an image and click Open to place it on the canvas. 

5. Click Magic Select to enable the tool you’ll use to remove 

the background. 0 

6. Drag the0corners or sides of the image until it removes 

most of the background while still featuring the subject you’d 

like to0keep. 

7. Click the Next button to remove the background. 

8. Use0the add and remove buttons at the top to draw on 

additional areas needing removed (or stuff that needs to be 

added0back), if necessary. Often times, this does the trick, 

and there’s no additional drawing needed, but some images 

are complex, and0require a little massaging to get a good 

finished product. 

9. Click the0Done button. 
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How to Use a Photo As a Texture in Paint 

3D 

1. Open0Paint 3D and click New to start a new project.  

2. Create a doodle, place a 3D object or add an item from 

the0Remix 3D community.  

3. In the top menu, click the Stickers icon. 

4. From0the sidebar, select the folder icon on the far 

right. 

5. Click Add sticker from the sidebar. 

6. Find0the photo you’d like to use as a texture and click 

Open. 

7. Click0Make 3D in the right sidebar. 

8. Choose Make sticker from the top of the sidebar. 

9. Stretch0the sticker to fit the shape. 

How to Create a 3D Doodle in Paint 3D 

1. Open0Paint 3D and start a new document. 

2. Click the paintbrush icon in the to menu to reveal a 

dropdown0with more options. 

3. Click the three dimensional box icon in the drop-down 

to select 3D0shapes. 



Windows 10 User Manual                                                                                                                                                     Kenneth I. Egbunu 

285 
 

4. In the right sidebar, choose one of the 3D doodle 

options: sharp0edge or soft edge. The former is good 

for items that have hard edges and lots of detail, while 

the latter is best for0softer items, like clouds. 

5. Draw your doodle by clicking on the canvas and 

dragging the0mouse around. You can also draw with 

your finger or a stylus on a tablet, convertible, or 

touch-screen PC. This,0obviously, leads to better 

results than my example, which is some sort of weird 

cloud. 

6. Use the handles0in the corners to resize, or the four 

options on the sides to change perspective or rotate the 

image. 0 

How to Rewind Your Paint 3D Build and 

0Share the Video 

1. Open Paint 3D0and click New to start a new project. 

2. Create a work of art, or a scribble. You can use 

whatever you0want, but we need some artwork in order to 

use the rewind feature.  

3. In the upper0right corner, click the clock icon. 

4. Move the slider left to rewind your work. From here, 

you can erase0parts you want to redo (scrub to the left and 
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then start where you’d like -- it’ll overwrite anything you 

previously0created after that point), or save the video. 

5. Click Export as Video to export your entire creative 

process to0share with others. 

6. Name the file, and press Save to store it. 

How to0Remove Paint 3D from Windows 

10 

1. In the0Cortana search bar, search for Windows 

PowerShell. 

 

2. Right0click the correct result and select Run as 

administrator. 

3. Type the0below phrase, then press Enter. 

4. Type the following command to uninstall Paint 3D, 

and then0press Enter. 

 

Thanks for purchasing! 
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